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.16, 30 seconds, 1S@ 400, 25mm, processed in Photoshop

Photography has traditionally been the realm of the real. It documents
things. You’d see something, snap a photo of it, and record that
moment for as long as your photo exists.

Then people realized that the reality you capture is only as true as the
camera’s perspective. Perspective could be toyed with. This changed
the way people worked with depth, color and reality itself.

Today, capturing reality is half the battle. Playing with multiple
exposures, HDR and perspective can create worlds beyond what we
can see with our own eyes. Trick photography takes that pioneering
kernel of photography —capturing reality—and takes it one step further.

Now, we capture the reality of our imaginations.

In the following pages, we’ll go through some of today’s more popular
digital photography tricks (some of which may even complement your
landscape and cityscape efforts), including some really fun ones like
light painting and spherical panoramas. The goal here is to help you
understand the full potential of photography, even the crazy stuff, so
you can instinctively recognize any photographic opportunity that
comes up—even if it comes up in recording high-definition video which
is now common with GoPros, you can see key frames and pull them out
to process as photos.

You won’t love everything. Photo experimentation is fun and
educational, but it also takes time and a very specific mind. Light
painters, for example, are a peculiar breed —you’ve got to enjoy
stumbling through the dark and accepting whatever comes out, like a
blind Jackson Pollock. Timelapse photography, meanwhile, takes hours
of post-production. Double exposures often call for precise foresight.

No photographer is great at everything. But with enough knowledge,
hopefully you can find a few techniques that help you discover your
own unique style.



Light Painting

Long-exposure photography is fun, sure.
But imagine a explosion of bright light—
rainbow colors, golden streaks, flying
sparks—all swishing and swooping fluidly
in otherworldly designs, even forming
legible words or distinct patterns.

This is the world of light painting, a niche
speciality of photography that relies
entirely on a combination of physical
artistry and long-exposure photography.

Light painting is conceptually easy: leave
a camera shutter open long enough, and
moving lights will etch their streaks into
the resulting image. We do this all the time
with regular cityscape night photography,
especially when cars drive through our
shots, leaving behind stripes of red and
yellow light.

But the creative possibilities extend far
beyond simple compositional photography.
Light painting is also what happens when
photographers set up their cameras for
long exposures in dark scenarios, grab

a light (say, a flashlight) and hop in front
of the lens to paint a picture on top of
the landscape. Light painters can draw
patterns, write words or overlay images
onto any given landscape or cityscape.
And it looks damn cool.

At its most extreme, photographers have
attached lights to hula hoops and swung
them around, creating surreal glowing

orbs in front of vast mountains like UFOs.

Others sign their names in the corners
of landscapes using laser pointers. True
professionals have mastered the art of
finding a tree in the woods, unlit even by

the moon, and controlling the amount

of light on every inch of space—they
understand precisely what luminance

will be achieved by raking light across
each object for a certain amount of time,
spotlighting different parts of the frame in
a mystical way. The possibilities are truly
endless.



Get started light painting

First, you’ll need the tools. The list isn’t
extensive, but it will get you out the door:

m A tripod
® Long-exposure control on your camera

m A dark location, indoors or outdoors at
night

m A light source—which sounds broad,
and is, and can be any of the following:
- Flashlight
- Glow sticks
- Light strips
— LED lights or strips
- Laser pointer
- Fiber optics
- Smartphone
- Sparklers

— Steel wool (more on this later)

You can even buy a specific tool for light

painting, such as the Pixelstick, a sort of LED
scepter that raised over $600,000 on Kickstarter,

truly marking the next generation of light

painters. But for beginners, a flashlight or glow

sticks are just fine.

Light up your John Hancock

As a light painting trial, | recommend writing your name in a shot. It’s easy, quick and quiet, and gives
a great introduction for the mechanics of light painting

Find a quiet, dark location—this can even be your bedroom to start, although moving around outside
may be easier—and set your camera on a tripod with a 10-second exposure. Then get in front of the
lens with some kind of focused light and write away. It will take some practice—timing the speed of
your movements and understanding light’s inherent delicacy takes time. But the results can be very
cool, even if you mess up.

(/2.8, 30 seconds, IS0 100, 17mm, Free Advertising by Zach Dischner).



http://www.thepixelstick.com/
https://www.flickr.com/photos/zachd1_618/8228912910/
https://www.flickr.com/photos/zachd1_618/

Your first awesome light painting: EXPLOSIVE STEEL WOOL

Using steel wool for light painting can be somewhat dangerous, but also a whole lot of fun—and

it almost always makes for incredibly bombastic, lively, explosive images, especially in barren
landscapes or abandoned cityscapes. A perennial favorite among light painters, this project is sort
of predictably unpredictable: the light will blast out in every direction, but your core image can be
controlled to an extent.

But this is important to clarify: the following activity is dangerous. | need to remind you all that I'm
in no way responsible for any burns or fires that result from you enacting this, and I’ll try to guide
you as best as | can to prevent that stuff from happening.

Items you’ll need for this project:

m Fine steel wool (not rough—the package
should have a zero, not a one or two)

m A metal wire container to hold said steel wool
(commonly a kitchen whisk)

Flexible wire or a thick cable

If wires, then wire cutters

A lighter

Safety goggles

An area with absolutely nothing flammable
around




And here is how you put the whole thing together:

Step 1: Assemble your flaming-mace thing.
There’s no good word for what we’re making: it’s
basically a knight’s mace, but on fire. Assuming
you’re working with a whisk, flex out your steel
wool a bit and stuff it inside the whisk. You can
also unroll the wool itself and cut it into smaller
pieces if necessary. If you have a cable, attach
the cable to the whisk; if you’re using wire, use
your wire cutters to cut a length into anything
between five and eight feet long and tie that

to the whisk. Make sure you’ve got a firm grip
on the non-whisk end of the metal rope by
fashioning a handle or something. Gloves are a
good idea.

Step 2: Find a location you won’t burn down.
Virtually no location is completely safe to swing
around fire, but places with less flammable
material tend to work better: think empty

beaches and deserts, not dry grassy fields or
crowded streets. While remote areas are safer,
though, know that sparks look more interesting
when bouncing off things, so if you can find
some boulders along the beach, so much the
better.

Step 3: Set up the shot.

Bust out the tripod and frame your shot. A
moderate depth of field like /8 is ideal, and a
low ISO speed works better to reduce noise
and focus the scene on your soon-to-be infernal
steel wool. If you want a brighter image, you
can bump up the ISO, but be sure to measure

it out with your shutter speed, which, of course,
should be long—though exactly how long will
depend on your idea and execution. Typically,
steel wool painting works well with 10 seconds;
go longer and the blaze gets brighter, go shorter
and the sparks get more detailed. If you do
choose to notch down your aperture, remember

that each stop downward approximately doubles
the amount of time you should be painting and
exposing your image.

Step 4: Test it out.

Take a few shots with a different light source
before you use up all your steel wool and realize
the effect didn’t pan out. Adjust your settings
accordingly.

Step 5: Come out swinging.

Ignite your makeshift mace with the lighter and
quickly click your camera’s shutter. Once the
steel wool starts to glow, carefully start spinning
it in a circle over your head. The more air gets
through to your steel wool, the quicker it will
burn and the more sparks will begin to fly. (That’s
why you want to fluff the stuff out first, to let
more air in easily.) Keep this going in any way
you want—a basic circle, or something more
resembling aboriginal fire poi dances.



Elevating your light painting

Already got a grasp on light painting? Wanting
to elevate it to the next level? Then let’s go over
some tips for cooler, more advanced imagery.

m Go big or go indoors.
When painting over a landscape, try to cover
a wide swath—and not randomly. See the
end product in your mind’s eye and get
creative with patterns that complement your
surrounding landscape or cityscape.

m Try different light sources.
If you’ve done steel wool to death, and are
bored of flashlights, move towards LED strips

or fiber optic cables to create different patterns.

You can even try setting longer exposures and
using multiple sources in a single image: spend

five seconds with a flashlight, five seconds with
rainbow-colored fiber optics and 10 seconds
with sparklers to achieve a blaze of multiple
lights at once. Try to fill your landscapes or
cityscapes with as many interesting and unique
colors as possible.

Play with intensity.

Using dimmable lights can help alter the
intensity of your light source at a given time,
but you can also achieve this by focusing more
on certain areas. If you’re painting the outline
of a tree and want the branches to be brighter
than the trunk, give your flashlight more time
there, or, using a dimmer, brighten up the
luminance. This kind of variety can help create
more precisely detailed images.

® Don’t shy from ambient light.

Use stars, lamps and city lights to your
compositional advantage. They’ll likely shine a
bit brighter, but it’s still better to integrate your
surroundings rather than awkwardly try and
avoid them.

Play with white balance.

By adjusting your white balance so it
misunderstands white as another color,

you can create eerie shots and change the
atmosphere entirely with a simple button.

This works especially well at night with celestial
bodies above, highlighting the moonlight in a
different color.

Use precise, artistic techniques.

Sure, you can swing a light around your head
for 20 seconds and gawk at the results—or
you can take a more delicate and toned-down
approach. Understanding the subtlety of light
is a huge factor in painting with it: gentle wrist
motions and graceful movements are what
separate the professionals from the amateurs.
It might look a bit like dancing—that’s a good
thing.

Study the masters.

Look to great modern light painters like Eric
Paré, Harold Ross and lan Hobson to discover
the vast differences in ways you can light

paint. Paré is mystical and intimate; Ross is
deliberate and classical; Hobson is wild and
psychedelic—there’s no right or wrong way to
approach it, but seeing how professionals work
(and most of these folks have tutorials and
behind-the-scenes videos) can shed light on an
artistry few recognize as even existent.



Using light painting in the urban
landscape

Practicing light painting can benefit you as

an artist beyond simply producing light-

painted images. The concepts learned through
controlling light on-screen translate into
nighttime long-exposure photography, especially
in cities. Once you understand how a camera
reacts to lights waving before it, you can better
understand how to set up and control your
scenarios, even they they seem beyond control.

I’ll remind you of some of the long-exposure
moments we discussed in the chapter on
shooting cityscapes at night. When confronted
with busy streets, heavy traffic, freeway
overpasses, intersections, busy airports or
spotlights at major events, you can use all these
moving lights to your advantage by accepting
their natural flow and recognizing natural
patterns. In some ways, this will help create a
more natural landscape out of whatever you're
shooting.

Most importantly, you’ve got to keep
experimenting. Photographers only improve by
trying new things. Even if inching around a dark
room with a flashlight doesn’t sound like the kind
of photography you want to do, there’s a lot you
can learn from the experience.

Video Tutorials on Light Painting:

m A short documentary on light painting, using a variety of objects

m Comprehensive steel wool photography tutorial

m Creating light orbs and using custom white balance

m Steel wool light painting, explained

® What happens when steel wool light painting goes wrong



https://www.youtube.com/watch?v=6kEgd2s9rR8&feature=youtu.be
https://www.youtube.com/watch?v=LJkBLMhXvcQ&feature=youtu.be
https://www.youtube.com/watch?v=HDWcDRup_Ss&feature=youtu.be
https://www.youtube.com/watch?v=tImh868ZI68&feature=youtu.be
https://www.youtube.com/watch?v=PQZrdqO95_k&feature=youtu.be

Panoramas & Spherical Panoramas

Count the number of times you’ve been
shooting a landscape or cityscape, taken
as many steps back as possible, and given
up, muttering to yourself, “My lens just
isn’t wide enough...” It happens to every
photographer. There’s never a wide enough
lens to capture it all—the vastness of the
world, the expansive horizon. The only way
to grab it is with a panorama.

Panoramic shots involve taking multiple
sequential images and “stitching” them
together. Take a landscape shot; shift your
tripod to the left, take another shot; shift
to the left, take another shot... Repeating
this process will give you a series of
photographs that can be stitched together
to make a super-long shot.

Today, there are lots of ways to capture
panoramic shots: most cameras offer
in-camera modes, and products like
Photoshop and Lightroom have evolved
to accommodate this niche section of
cityscape and landscape photography
specifically.

Regardless of how you go about stitching
your shot together, how you take the initial
series will be a very similar.

Photography Tricks
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What you need to shoot panoramas:

m A sturdy tripod, preferably with a ball head;

m A bubble level on the tripod—standard
levels are useful, but a double-bubble level
that attaches to your camera’s shoe mount
is even better;

m A wide-angle lens.

General tips for panoramas

For every shot, you want to ensure your
settings are the same —switching focus,
aperture or focal length midway through the
series will mess up the whole thing. Stay in
Aperture Priority mode, and keep your aperture
relatively high (high f-stop). A consistent deep
depth of field matters here. The same goes

for focal lengths: no zooming in or out, or the
image’s perspective will be all wonky. Finally,
switching to manual focus is a good idea, just in
case autofocus decides to switch up between
shots.

Next, though the natural tendency is to shoot
panoramas horizontally, it’s actually more useful
to shoot vertically. This way, even though you’ll
be taking more shots, you’ll have more room to
crop the top and bottom of your final image.

Lastly, I'd recommend avoiding in-camera
stitching. Experimentation is fun, but | find the
in-camera stitching often makes a mistake,
making it more difficult to process the image
after the fact. If you’re inclined to try it anyway,
insure yourself by taking a series or two as well.

Types of panoramas

There are two types of panoramas: partial
panoramas and 360-degree panoramas.
Partials are more common: you’ll see them

for sale in galleries, or hung up on walls in art
houses or businesses. They’re super-wide
landscape shots. Often they’re composites of a
few images, between 5 and 10, that grant a 120-
or even 180-degree viewpoint of a scenario.

But the types of shots that attract more views
online, in my experience, are 360-degree
panoramas —the result looks like a sphere of
universe curled up into itself. They’re a little more
complicated to pull off, especially if you want
lots of detail, and often require more than 10
shots to cohere. But they’re a good deal of fun:
they distort our reality, yet not entirely; they show
us a view of our world we would never otherwise
be able to see.

Panorama Il, London by Davide D’Amico.

How to shoot a partial panorama

First, consider your final composition. Too many
photographers forget this part: rather than just
shapping shots for the sake of a stitch, it's better

to have a clear idea in your mind’s eye of how the
finished product will look. Consider the rule of thirds
in a wider sense and use the extra length given to
leading lines to enhance the scene.

Once you'’ve set up your camera—accounting for
exposure and aperture as well as composition—take
your first photo and rotate your tripod rig slightly.
Then take another photo. Try to overlap your images
by around 25 percent, so you can stitch them
together effectively later in post-processing. If you’re
using a very wide-angle lens, overlap by 40 percent
to be safe. After taking enough shots, you’ll learn
what amount of crossover works best with your
lens. Continue shooting until you capture the whole
landscape or skyline. As | said before, anything
between 120 and 180 degrees is common.

If you continue shooting like this until you’ve
reached a full circle, you’ll wind up with a
360-degree panorama. They usually look a little
funny—a bit warped, depending on how well
they’re stitched together—but can make for terrific
landscape shots, especially from the tops of
mountains.


http://www.amazon.com/gp/product/B00005QFAF/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B00005QFAF&linkCode=as2&tag=pictuphototip-20&linkId=UK23QYEOXMLJTYCM
https://www.flickr.com/photos/davidedamico/14626177248
https://www.flickr.com/photos/davidedamico/

How to shoot spherical panoramas.

With spherical panoramas, it’s more about capturing everything—and

| mean everything —rather than accuracy. I’'ve found that a tripod can
actually hinder my chances here, and that | can work faster without one—
although you’ve got to have an eye for accuracy on your own, which a
tripod does help immensely with.

With or without a tripod, you want to capture everything you can see in
however many shots are necessary. How long this takes will depend on
your lens: fisheye lenses can capture 180 degrees in a single shot, and so
can technically grab everything you need in four quick shots, similar to a
360-degree panorama.

Without a fisheye, though, you’ll need to incorporate not just 360 degrees
of panorama, but also vertical shots from your feet to the sky. Think of it
like peeling an orange in slices, starting at the bottom; peel one strip from
top to bottom, then rotate slightly and start again. Once you’ve “peeled”
the whole world around you, you’re set.

Beware the parallax

Before we get into post-production, a quick word on parallax—a daunting-
sounding sciency word that’s really much easier to work around that you
think.

First, what is parallax? It’s the visual phenomenon that happens when
stitched-together panoramas don’t quite fit. Parallax is the cause of
“ghosting,” when objects in a panorama transparently half-appear but don’t
really, or when stitches appear blurry in a final product. In short, it’s the
byproduct of tilting a lens without moving it appropriately enough to create
a fluid panoramic shot.

You can see the effects for yourself. Close one and hold a finger in front

of your face, but focus your eye on something behind it. Now rotate your
head left and right. Notice how it seems your finger is moving? It isn’t, of
course—but your angle of perception is. That’s because your point of view
is no longer perfectly centered—it’s slightly askew.

There are ways around this, of course. The trick is to find the “no-parallax
point” of an image, also sometimes known as the “nodal point.” When the
camera is far from physical objects—if your landscape is entirely in the
distance, say, as in the top of a mountain—then parallax isn’t as much of
an issue. Sometimes it's completely avoided, since the nodal point and the
rotation point don’t cause much discrepancy.

Another way around the parallax effect is with a wide-angle lens for much
the same reason. Because they make everything seem far away, they
effectively replicate the distance effect that works when the camera is far
from its panoramic subject—presuming there are no foreground objects to
muck up the shot, of course.

But the easiest way is, without question, using a panoramic tripod head.
This repositions your camera as you swivel, so that you dodge the nodal
point of the lens. If the investment in new gear doesn’t seem worth it to
you, then you’re going to have to work around the problem manually.

Photography Tricks 12



Software for post-processing
panoramas

The most commonly used software on the market
is Photoshop, but there are numerous plugins
that are made specifically for helping to stitch
together panoramic shots; among them, Flexify

2 is probably the most popular. If you don’t have
Photoshop, there are a number of free and open-
source image editors on the market, like GIMP
(with a plugin called Pandora) and Hugin. PTGui
is also a quality product for producing 360-degree
and spherical panoramas with ease, but it will
cost in the low three-digit range to buy.

Finally—let’s make your panorama

By now I’ll assume you’ve snapped all your shots,
downloaded the requisite software and avoided
the necessary parallax woes. It’s time for the real
hard work: stitching together your panorama in
post-processing.

The possibilities of panoramic post-processing
are limitless. If this is your first go at it, you’ll
likely want to try a number of paths to see the
differences before settling on whichever style you
like best. Most of this will likely require Adobe
Lightroom or Photoshop—the Photomerge
Panorama tool in Photoshop is one of the most
useful for combining multiple images into a single
continuous one—whether the shots are horizontal
or vertical. This is a reasonably accurate tool,
assuming your shots can gel together. To make

it work, just open your photos in Lightroom, then
select them in “Library” view. Then go to the
photo menu at the top and click “Photo,” scroll
down to “Edit In,” then hit “Merge to Panorama in
Photoshop.” It should look like this:
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Then choose which layout option you want to try:
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The layout options might seem confusing, so we’ll break them down here.

® Auto means Photoshop itself analyzes the source images to figure out
how the final panorama will look best: either a perspective or cylindrical
layout. If “perspective” and “cylindrical” confuse you, keep reading.

®m Perspective creates a panoramic composition by assuming the
middle image—e.g. number three of five—is the one with the correct
perspective. It then transforms the other images by repositioning,
stretching or skewing them in order to match the overlapping layers.

® Cylindrical reduces the “bowtie” distortion that sometimes happens with
the Perspective option. It displays individual images as if they’re on an
unfolded cylinder. Overlapping content is still matched, and the middle
image is still the reference point at the center. This option is better for
wider panoramas.

m Spherical aligns and transforms your images as if they were wallpapered
on the inside of a sphere. This is how you’d make 360-degree
panoramas, but could also be used for nice panoramic results with other
file sets.

m Collage matches overlapping content, while rotating or scaling the
source layers. A little more scattershot than the others, which use the
middle image as a commanding reference point.

m Reposition aligns the layers and matches overlapping content, but does
not transform any of the source images by stretching or skewing.

m Interactive Layout is effectively a manual mode, good for opening the
source images in a dialog box and positioning them yourself.

There are other settings, too, of course, that are more niche and complex.
You can use Blend Images Together to, well, blend your images
together—this option finds the most fitting borders and smooths out their
colors and lines. Turn this setting off, and a harsh rectangular blend is
used. You might prefer this if you want to retouch your blending masks
manually, but novices may appreciate the auto mode.

Vignette Removal is a useful tool for dealing with uneven exposures in a
single image. This setting will remove and compensate for darker edges
(often caused by lens flaws or improper lens shading).

Lastly, if you have any major distortion—barrel, pincushion or fisheye—you
can turn on Geometric Distortion Correction to put everything in its right
perspective.

In general, I’ve found the auto options in Photomerge to work fairly well.
But if they ever don’t produce the outcome you want, use the Interactive
Layout option and do it yourself. You can use the Photomerge dialogue
box to manually rearrange source images and perform touch-ups on
distortion and blending.
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How to make tiny planet panoramas

I’m sure you’ve wondered about those imploding little balls of landscape —tiny planets, spherical panoramas, however you want to call them. They seem
like a neat trick, and get a lot of hits online because of their innovation, bright colors and creative perspective on the world.

While it’s common to start with a full 360-degree panorama, that’s actually not necessary. The technique works best simply when the ends of the
panorama—the seams—blend together. This is obviously easiest with a 360-degree span, but it’s not strictly necessary. With a consistent sky, almost any
landscape panorama can be spherified just as well. And it’s much easier than you think.

For this walkthrough, I’'m going to use this image | took from The Bund in Shanghai. Feel free to download it from Flickr and follow along, or else use one
of your own.

1. Open your image in Photoshop. 2. Make the image a perfect square. Find “Image” on the top banner, then
select “Image Size” and adjust the height so it’s the same as the width.
(You might have to deselect the “Constrain Proportions” option so you
can adjust the height independently of the width.)
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https://www.flickr.com/photos/picturecorrect/10313948605/

You might notice some squishing. That’s okay—it’s all part of the process.
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3. Now flip the image. Under the “Image” option, select “Image Rotation”
and rotate it 180 degrees. Conversely, you can select “Flip Canvas

Vertical” under the same tab.
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4. Apply a Polar Coordinates Distortion filter, under the “Distort” section of
the “Filter” option. Make sure to select “Rectangular to Polar.”
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5. That’s about it! As a final touch, you can crop it or use the clone stamp
tool to remove seams or blemishes in the corners of the sky.

Keep in mind that if you don't flip the image (Step 3), then when you apply
your distorting filter, you’ll find the opposite result—your land will stretch
around the outside of a circle of sky in the middle. That can also be a very
cool photograph, if you’ve got a consistent image with a tall tree or pointed
figure sticking out in the middle, breaking the perfect horizon on its own.




Combine your tricks: Beyond the basics Looking for visual tutorials on

Make a HDR panorama . . panoramas?

For other types of panoramic processing,
Want to take your panorama skills to the next check out a popular Photoshop plugin called Check out these great videos on YouTube,
level? Try taking bracketed shots of each Flexify 2. Just as panorama processing which | found pretty helpful when starting out:
panoramic section. Convert each individual variations are virtuaIIy endless, so too are the
section into an HDR image by using the outputs of this plugin, many of which involves m How to Photograph a Panorama
techniques we went through last chapter, and barely pronounceable words. Here are just afew: g The Keys to Panoramic Photographs and
then merge those together in Photoshop.

g g I P ® Mirror ball m Polar HDR Panoramas

You can also use Lightroom presets on each m Half-polar m Orthographic ® Finding the No Parallax Point
panorama SeCtIO:’I before alllgnlr_19 the,m Wlt_h m Tetrahedron m Cube ® How to shoot a 360 Degree Spherical
Photoshop. That's a good idea if you're trying Panorama in 90 seconds (using a fisheye
to improve your results with a quick catch-all ® Octahedron ® Dodecahedron lens) Y
approach. m |cosahedron ® Sinusoidal

® Rectilinear m Hyperbolic ® How to Make 360 Degree Tiny Planet

) o Panoramas in Photoshop
m Stereographic ® Cylindrical
m Pinwheel ® Quasar

Panorama of Down Town Manhattan by Neo |I.

Photography Tricks 17


http://www.flamingpear.com/flexify.html
https://www.youtube.com/watch?v=WoQNL-VsvJA&feature=youtu.be
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http://How to shoot a 360 Degree Spherical Panorama in 90 seconds (using a fisheye lens)
http://How to shoot a 360 Degree Spherical Panorama in 90 seconds (using a fisheye lens)
http://How to shoot a 360 Degree Spherical Panorama in 90 seconds (using a fisheye lens)
https://www.youtube.com/watch?v=Q_GvblGsqo4&feature=youtu.be
https://www.youtube.com/watch?v=Q_GvblGsqo4&feature=youtu.be
https://www.flickr.com/photos/neo_ii/7483021056
https://www.flickr.com/photos/neo_ii/

Levitating subject(s

Photography is stillness. We can try to capture motion, but a
photograph will inevitably be an unmoving moment, a single
fraction of a second. Few photography tricks play to the beauty
of that stillness like levitation.

Levitating someone on-camera is among the most eye-
catching—and mind-bending—photographic tricks around.
Imagine seeing someone floating gracefully in mid-air,
surrounded by a lush natural landscape. It’s a really beautiful
moment that any landscape photographer with a surrealist eye
has surely tried at some point.

We all float on

There are two common techniques for making someone appear like
they’re levitating: the natural way and the post-production way.

The natural way means you need to find a calm, acrobatic and talented
jumper—someone to literally jump in mid air, but not look like they’re
jumping while they’re doing it. This requires extreme precision and
patience to catch exactly the right moment and illustrate an emotional
state of mind at the same time. Much easier said than done: have you
ever tried jumping casually? It’s a bit of an oxymoron.

The post-production way requires a prop to stand on, like a stool or

a chair. The person can stand on the stool and, using the clone stamp
tool, you can remove the object after the fact and replace it with your
background. In landscape scenarios, this can be as easy as setting a
stool on the beach, and then disappearing it among the sand. If you're
going to attempt this, make it easy on yourself at first—no need to try to
match the background of a complex cityscape.




Levitating tips

Whether you’re forcing a model to jump up and
down repeatedly or trying to perfect their tip-
toeing on a stool, there are some very handy tips
for levitating subjects in landscape or cityscape
photography.

® Quick shutter speeds are a must. Your subject
can’t be blurred from motion at all, or else it
spoils the whole illusion.

®m Consider using props to fill in the scene.
Nothing says “magical floating” quite like
holding an umbrella in mid-air.

m [f you're post-processing the illusion, be sure
to shoot in overcast weather. Clone stamping
away the stool or chair becomes much
easier when you don’t have to contend with
shadows.

m Also for post-processing: always take
variations on the same shot. You’ll need at
least one of the scene without the subiject;
one of the subject standing on the platform;
perhaps one of the subject on the platform
with his or her hair lifted up, as if they were
standing in zero-gravity; and maybe a few of
various items of clothing (if appropriate) being
lifted up for similar effects. Getting all these
shots in advance makes it much easier to
accomplish the final effect. You can do this by
combining the best attributes of each photo,
similar to the way we process HDR.

Examine the pros

The international queen of levitation
photography is arguably Natsumi Hayashi,

a Japanese photographer who’s made a career
out of shooting herself in mid-air. Her technique
is seemingly simple, but arduous to nail down:
she is a graceful jumper, and uses a self-timer
to snap several shots while she’s in the air. It
sometimes takes her up to 200 tries to manifest
the image in her mind.

If you want to read an interesting article wherein
some of the best levitation photographers share
their setups, check out this one on Fstoppers:
“Secrets of the Best Levitation Photos
Shared.”

Lastly, here’s an interesting YouTube video
walking viewers through a levitation photo

shoot, including a glimpse at the post-
processing techniques.
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http://yowayowacamera.com/
https://fstoppers.com/bts/secrets-best-levitation-shots-shared-8027
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Long exposures during the day

Take a shot of a river. On a clear day, you can probably see the water surging through, one droplet at a time; the clouds flat against the
sky; and any little bugs or birds flying through the frame. This is not necessarily a bad way to shoot a river landscape, but it’s not the way
most professionals do it.

To create a sense of flow and power in the river, most professionals would leave the shutter open for longer than usual. But there’s a
problem: by leaving the shutter open longer, you’re exposing the camera to way more light. On a sunny day, over-exposure is inevitable.

That is, unless you have a neutral density filter—or ND filter, for short.

What’s an ND filter?

An ND filter is basically a pair of sunglasses for
your camera. They allow less light to reach the
camera’s sensor without really changing the
lighting or color, so you can leave your shutter
open longer without worrying about over-
exposure.

ND filters can be either screwed onto the front of
a lens, or else slotted on (if you have an adapter
and a holder, which are less common). They’re
made of either glass or polyester, with glass
being the better (and relatively pricier) option.

= L

- L
BY EEEERER
EV EREEBER
B RRERERR

How an ND filter works — sort of like your lens is wearing sunglasses, blocks light from reaching the sensor allowing you to reach longer
shutter speeds.
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Why use an ND filter?

There are loads of different shots you can take with an ND filter, both in
cities and landscapes. In either case, the main reason people use long
exposures is to create a sense of movement.

Consider a crowd of people moving through a busy street market. A long

exposure can create ghostlike creatures out of human bodies. If there’s a

solid standing centerpiece—a person standing still, a statue or a crowded
building—then the effect is doubly impressive.

This works well on cars, also. Usually streaking headlights only appear at
night, but with an ND filter you can create long streams of cruising metal
during daytime hours as well.

In landscapes, water and clouds are the most common reasons to pop
on an ND filter. These natural movements look somehow static when
captured with a normal shutter speed. Longer ones can turn spotty rivers
into flowing torrents, and a few clouds into a haze of whiteness.

In any case, ND filters and long exposures tend to add depth and texture
to otherwise flat shots. A filter is a one-time investment, and one which
every pro photographer should make.

ND filters: variable vs. fixed

There are two types of ND filters on the market: variable filters and fixed
ones. Fixed filters come with a set degree of dark stops, which are ideal
if you can understand the lighting situation you’re in.

The biggest benefit to fixed filters is that they’re more precise and of a
higher quality. The problems, though, are twofold: firstly, even though
you can layer them atop of one another, that gets pretty expensive.
The second problem is the time it takes to do that.

Variable filters can simply be adjusted to fit a range of lighting conditions.
They take a slight hit in terms of image quality depending on the lens,
but the benefits even it out: they’re much faster to work with and lighter
to carry around. Ultimately, it’s your call.

Without nd, 1/400 sec

With nd, 1 full second shutter speed. The filter used here was a Tiffen 77mm Variable ND Filter.

Photography Tricks
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Still subjects during long exposures

At the end of my chapter on shooting
motion from pedestrians, | mentioned a
common type of very poetic shot: a single
person standing still among a crowd.
Homeless people, human statues or
individuals sitting on park benches make
ideal subjects for this type of shot; they
seem ignored by a world that’s passing
them by.

Well, now we’re going to talk about how
to do just that—as well as riff off that idea
to brainstorm other types of shots that
involve still subjects in front of moving
backgrounds.

The background, of course, doesn’t have
to be made of moving people. There’s no
shortage of movement in cityscapes, or
even landscapes: you can shoot a subject
standing in front of a moving waterfall,
zipping traffic or any kind of special event,
like a parade. Creativity is key here: the
more of these shots you take, the more
perceptive your eye will become for what
could work as a potential long-exposure
shot.

The reason these shots work so well,
to harken back even further, is because
they look interesting. Let’s recall the
early chapters of this book, wherein we
established what makes an interesting

/14, 6 seconds, ISO 160, 24mm, for this shot | asked my friend to try to stand as still as he possibly could on that square where the lines
intersected. There is so much activity and movement at this place, Shibuya Crossing, that this was the result. 3 shot bracketed exposure, used
exposure blending to combine the best attributes of each. The “portrait in the city” Lightroom preset was applied to each of these.

shot—remember contrast and texture?
They’re the two key elements we see

in this type of photography. We’re
contrasting stillness with motion, and
using that motion to blur out a wonderful
background texture against the sharpness

of a foreground subject. Add some
interesting composition and maybe a few
leading lines, and you’ve got all the basic
tenets of photographic law. This isn’t
groundbreaking stuff—it’s Photography
101, just with a twist.



Still starting, starting still

This photographic trick is extremely easy to
prepare for. Beyond the scenario itself (a willing
model, a moving background), all you need

is a tripod to get started. At night this comes
particularly easily, because long shutter speeds
come naturally; however, as we discussed in the
previous chapter, you can also set it up during
the daytime with an ND filter blocking out the
light.

You can set your exposure/shutter speed to any
pretty much anything longer than 1 second and
the technique will work. As you can see in the
example photo here, shutter speeds between

1-5 seconds produce blurred individuals with
that are still somewhat defined. Shutter speeds
between 5-10 seconds produce less defined
streams of blurred masses. Both can work well,
it just depends how you want your final result

to look. Some of my best images including the
example provided in this chapter have come
from combining multiple bracketed exposures
implementing a range of shutter speeds. As with
HDR and numerous other techniques mentioned
in this book, exposure bracketing is extremely
useful for balancing out variances in bright lights
and darkness - and in this case amounts of blur.

Here are the bracketed shots so you can see the shutter speed results:

And if you’re shooting yourself—especially in

a cityscape selfie scenario—feel free to ignore
everyone stopping and looking at you strangely.
Confidence is a great deterrent against
onlookers, and they’re likely to shrug and move
on. Besides, the longer your set shutter speed,
the less likely any gawkers will visibly show up in
your shot. (And besides, even if they do, it might
look kind of cool.)

4 seconds

2 seconds

8 seconds
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1/8, 30 seconds, IS0 200, 14mm, full speed ahead by Robert S. Donovan.

Tricks for when you don’t have a tripod

| admit, a lot of the tricks we’ve talked about up until this point have relied on long exposures. And while I’'ve dealt with ways to
survive scenarios where tripods aren’t allowed in an earlier chapter, | can’t stress enough how important it is, and how doable certain

photo tricks are regardless of whether or not you have a tripod handy. The point | want to drive home is to get you thinking like a
photographer—think creatively and resourcefully, regardless of the situation.



https://www.flickr.com/photos/booleansplit/11017249736
https://www.flickr.com/photos/booleansplit/

Tripods, tripods everywhere!

Look for objects you can use as tripods in a
pinch. Cities are filled with these things. Try,
for example, setting your camera down on...

® Mailboxes

m Fire hydrants

® Fences

m Walls

m Curbs

® Benches

® Rocks

®m Thick hedges

® Railings

®m Parked cars

m Tabletops

Most of these can be found pretty frequently
around a city. Nothing available? Then MacGyver

your own tripod with some makeshift materials.
Try using...

m Rolled-up jackets or shirts
m Stacks of books

®m Backpacks or luggage

B Shoes

® Camera bags

A new perspective

Even setting your camera down on the
ground can produce interesting long exposure
results combined with a unique perspective.
Sometimes, these shots become our most
interesting ones, precisely because of how
unexpected they are.

For most of these you’ll need to set your
self-timer on anywhere between two and 10
seconds. if you’re setting your camera up on a
makeshift tripod that’s so high or low that you
can’t see the viewfinder, keep in mind the basic
rules of blind shooting: switch to manual focus,
focus on your subject in advance and zoom in
beforehand using live view to ensure a crisp
shot, set your camera down and then leave it
alone. By using manual focus, you’re ensuring
that autofocus won’t screw anything up when
you press the shutter button.

The Pocket Pod tripod substitute.

Tri-possibilities

Of course, if you want tripod options that aren’t
tripods, don’t want to muck up your sweater,
don’t trust stacks of books and have a bit of
cash to spare, there are a few great low-key
alternatives to tripods on the market.

m Pocket Pod - a bean bag system that’s ideal
for SLRs that need lenses propped up.

m Pocket Pod XL - a larger version of the
Pocket Pod.

®m GorillaPod - a mini-tripod with movable
legs—ideal for uneven surfaces.

® The Pod - a bean bag deal with a tripod
head-sized screw top.

m Pillow Pod - which is, for all intents and
purposes, an SLR-sized bean bag.



http://www.amazon.com/gp/product/B001704AOO/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B001704AOO&linkCode=as2&tag=pictuphototip-20&linkId=QYRZ76YR7ZPZJQZV
http://www.amazon.com/gp/product/B004DP33IY/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B004DP33IY&linkCode=as2&tag=pictuphototip-20&linkId=6B7GCPENTXAYY4AD
http://www.amazon.com/gp/product/B002FGTWOC/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B002FGTWOC&linkCode=as2&tag=pictuphototip-20&linkId=4H57COXLNDZZX2LE
http://www.amazon.com/gp/product/B001QOGVQQ/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B001QOGVQQ&linkCode=as2&tag=pictuphototip-20&linkId=GN7R4QYJXXFN3POL
http://www.amazon.com/gp/product/B0002ER322/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B0002ER322&linkCode=as2&tag=pictuphototip-20&linkId=SUPBYS64INRRH2GZ
http://www.amazon.com/gp/product/B001704AOO/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B001704AOO&linkCode=as2&tag=pictuphototip-20&linkId=GPOIQXEM7GHI6MJA

Swapping out a Sky

Sometimes you might capture a landscape/cityscape with an amazing foreground, but the sky in the background is bland and boring.
It might be a good candidate for a sky replacement! As we talked about earlier in the book, cloudy or stormy skies can be much
more dramatic then solid blue skies. So if you see a great sky, take a few extra photos, you might be able to use them later as a sky
replacement as we will show you how to do here.

1. In this example, | took this shot of an interesting and strange building up 2. So | went through my other photos from the same trip looking for a good
in the mountains. The grass, building, and mountains are all fantastic, sky candidate and settled on this one:
but the sky is solid blue without a cloud in the sky and doesn’t add much
interest.
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3. Now | open those two photos as layers in Photoshop. Using Lightroom
you can do this in the Photo menu at the top and click Edit in > Open as
Layers in Photoshop. You can also do this using Adobe Bridge. Once in
Photoshop | recommend putting the primary photo as the top layer. Then
add a layer mask to the primary photo.
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4. With the layer mask selected, use the Quick Selection Tool to select the
sky. The tool should select it easily if it is solid blue.
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5. Then, with the layer mask still selected, switch to the Paint Bucket
Tool, make sure the color you are using is black, and bucket the whole
selected sky Black. This will tell the layer mask to let the bottom layer
show through so you should see your new sky now.
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7. Final Result: And here | took it back into Lightroom and applied the
“Just Right” Lightroom preset to improve Color/Contrast a bit.
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6. And that’s it! So here you can see the preliminary result.

Photography Tricks 28



1

Star Trails
[ |

at Night
Have you ever looked up at the stars and
stood in awe of how minuscule humanity
seems? Seen the billion-year-old beauties
glimmering from light-years away? Almost
every landscape photographer has, as
well—and the challenge of capturing that

awesomeness is among the greatest in the
field of photography.

Capturing star trails demands patience,
skill and a number of techniques we’ve
used before in this book. But the payoff is
worthwhile: star trail photography actually
captures the full rotation of Earth in relation
to the stars above. The results are almost
always amazing and baffling: streams of
starlight cascading curvaceously across
the night sky, the length of the streaks
dependant on how patient you were during
your outing.

But there’s more to it than just that, of
course.

The right light

Lighting is arguably the most important part of a
starry photoshoot. You’ll need to find a location
far away from cities or light pollution, which
obscure our views of the stars and brighten

up the sky with our millions of streetlamps and
apartment lights. (The Light Pollution Science
and Technology Institute has some helpful
maps here that show you where you can travel
to in order to escape light pollution.)

But even if you find a remote area, you’ll need
nature’s help, too. Moonless nights are best,

so the light from the big glowing orb doesn’t
interfere with your delicate long exposures.
Cloudless nights are a given—clouds would mug
up the whole scene.

Another good tip for starting out is to try and
spot the north star, Polaris. All the stars will
circle around it, so its position will give you some
idea of the curvature of the stars themselves.

If Polaris isn’t visible from your vantage point,
don’t fret: the stars will seem to travel across
your scene in a partial circle nevertheless. This is
also the case with the South Celestial Pole.

Framing that matters

It might be difficult in the pitch-blackness (which
is why knowing your scenario beforehand is
useful), but finding an interesting foreground

that will work with long exposures is a great and
often surprising addition to star trail photography.
Mountain ranges or old buildings (no lights,
obviously) work well to occupy the third of your
composition, which still saves you plenty of sky.
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A few notes on camera setup

This is imperative: your camera must be
absolutely still. We’re not just talking about
long exposures—we’re talking about two
hours of stillness in sequences of 30-second
exposures. Position it firmly, and weight it down
if possible, so the wind won’t move it at all.

Use manual focus, and focus to infinity (in
most situations). That said, sometimes | find
it’s better to use Live View to manually focus
on a bright star.

Turn off image stabilization—since we’re using
a tripod with long exposures, we want as little
mechanical movement as possible.

Turn off in-camera noise reduction if
applicable to your camera.

This goes for every shoot, but is especially
important on these long hauls: make sure your
battery is charged and that you have a spare.
Not only is star trail photography especially
good at draining batteries, but many
professionals will shoot the same long
exposure shots until their batteries die. Make
that time last.

This tip is optional: consider shooting in JPEG
instead of RAW. | only suggest it because of
how many images you’ll be shooting—smaller
file sizes work in your favor, and the StarStaX
processing software (which we’ll discuss
soon) doesn’t support RAW files. Of course,
you can always export JPEGs from Lightroom
fairly effortlessly.

Depending on the weather and time of year,
some professionals will invest in dew caps to
prevent dew from forming on their lenses.

The method behind the starriness

There are two prominent methods for capturing
star trails. The first and most common method
involves capturing lots of sequential images
using an intervalometer. These tend to be
30-second exposures, one after another, over
the course of one or two hours. (You can do
more, but one or two should be sufficient; the
longer you shoot, the longer your star trails will
be.) Once you’re done, you can go home and
stack them all together in post-processing.

But there is another—and riskier—way. You can,
if you want, shoot one very long exposure —
approximately one hour is recommended—and
this will show some decent star movement

in and of itself. The biggest drawback here is
the obvious risk involved —what if the camera
moved a bit and you didn’t notice? You may find
your “all-eggs-in-one-basket” approach yields
nothing more than an hour-long cracked egg.

For that reason, | recommend stacking your
images in post-processing. We’ll start with a
guide to that method before delving into the
single-exposure one.

“My first successful star trail photo. Basically | set the camera to take 30 seconds exposures one after the other for 3 hours until the battery ran
out. | stacked the resulting 300 some odd photos and this is the result.” f/4, 160 1SO, 17mm. Star trails at Killbear Provincial Park by Imtiaz Ahmed.



https://www.flickr.com/photos/imtiazwahmed/9546365483
https://www.flickr.com/photos/imtiazwahmed/

“This was my second attempt at doing star trails. The photo consists of 108 photos all consisting of 30 second exposures.” /5, 1ISO 200, 17mm.
80/365 Star Trails by Mike Poresky.

Method one: Stargazing in spurts

Before we get started, know that owning
an intervalometer will make this process
considerably easier. It’s a handy automating tool
that runs on its own, so you don’t need to waste

time every 30 seconds resetting your exposures.

Once you’re in position, you should begin by
switching over to your camera’s manual mode.
Use a wide-open aperture, the lowest f-stop

possible; in this case, scarce light trumps our
desire to have a deep depth of field, and a
wide aperture lets in as much light as possible
from the slim amount of starlight available.
Unfortunately, lens quality matters here, too:
expensive lenses capable of low f-stops will
visibly outperform lenses that don’t drop below
/3.5. The wider your aperture, the brighter your
stars will shine.

Shutter speed we’ve discussed—30 seconds
should do it. And don’t worry about white
balance; any fixed setting is fine, such as
daylight or shade. (Just try to avoid auto white
balance, which may result in color variations
between exposures.)

A more complicated setting is the ISO. Obviously
higher is better, as this lets in more light and may
reveal fainter stars, but a too-high ISO can also
bring about more noise. I’d recommend testing
out a shot with ISO 1000: if your sky still looks
dim, keep increasing the ISO until you have a
shot full of stars. Hopefully you won’t need to
delve into too noisy territory to find that spot.

With the settings taken care of, set your
intervalometer to continuous shooting and kick
off the sequence. Let it run its course, snapping
30-second exposures for anywhere from 30
minutes to two hours. One hour is a good first
goal, as this will usually deliver a dramatic
enough image with long, overlapping trails.

A quick (and advanced) technical note: Some
true (and truly dedicated) professionals
sometimes won’t use an intervalometer. This is
because sensor heat can be an issue with this
method of photography, and by avoiding the
intervalometer they can give the sensor some
time to cool down between shots. The hotter the
sensor gets, the noisier your exposures will be.
But be aware that this level of dedication can get
extremely tedious. Also, longer waits between
shots can create larger gaps in your star trails.


https://www.flickr.com/photos/mikeporesky/5307929827
https://www.flickr.com/photos/mikeporesky/

Method number two: The longest
exposure you’'ll ever take

Here is the aforementioned riskier of the two

methods: the single, hour-long exposure. For
this technique to work, it is even more critical
that you have an absolutely clear sky with no

moon visible and no big/thick clouds passing by.

Similar to the previous technique, a high-quality
and fast lens—preferably one that can achieve
around /2.8 —will boost your results here. Start,
if you can, with your lowest f-stop, and only
raise it if you feel you need to balance out a
longer shutter speed. We’ll also reverse our ISO
methodology down to 100 now, since the long
shutter will handle the light factor.

As for the shutter speed itself, it's something of
a matter of trial and error. Different scenarios
will be affected by different lighting situations
and how remote your location is. This could
mean anything from 30 minutes to three hours.
Experienced photographers will sometimes take
a few test shots, substituting long exposures
with a very high ISO to try and make an
educated guess as to how long their shutter
speed should be. If the test shot is perfectly
bright when set at the highest ISO and a
30-second exposure, then a similar result might
be accomplished with a one-hour exposure and
the lowest-possible ISO.

Once those settings are done, program your
intervalometer for the desired shutter speed
length, anything from 15 minutes to an hour.
You’re done for now—come back when it’s
finished and see how it turned out.

Single exposure technique. “I should have let this shot develop a little longer, but after 18 minutes | got impatient. The star trails over Mono Lake
are faint and short as a result. Live and learn.” 18 minute shutter speed, /10, ISO 100, 28mm. Mono Lake Star Trails by Joe Parks.

Starry software

There are a few software options when it comes
to stacking or compiling star trail shots together.
Here are the most common:

m StarStaX ® ImageStacker
m DeepSkyStacker m Startrails.de
m Star Tracer

My preferred software is StarStaX (you can
download it here), and so even though all of them
work similarly, I’'m going to use StarStaX for this
walkthrough. What these programs do is blend
your series of star trail shots into a single image
using any number of blending modes and options.

The program itself is fairly straightforward:
simply drag and drop your photos into the
lefthand column, select an output folder and
click “Start Processing”. That’s it. The program
will merge your sequence together, even filling

in the gaps between star trails (if you did the
30-second on-repeat version, such little spots
may occur) if you use the “Gap Filling” option.

Also keep in mind that, in some situations, you
can use this starry trail sky to swap out a night
sky using the technique we discussed in the
previous chapter.

Watch it yourself

Curious to see star trail photography in action?
These YouTube videos offer a solid glimpse into
the technique.

m Star Trails Photography Tutorial
m How to Make a Star Trail (Beginning to End)

m Image Stacking Demonstration with
StarStaX



http://www.markus-enzweiler.de/StarStaX/StarStaX.html
http://www.tawbaware.com/imgstack.htm
http://deepskystacker.free.fr/english/index.html
http://startrails.de/html/software.html
http://www.tawbaware.com/startracer.htm
http://www.markus-enzweiler.de/StarStaX/StarStaX.html
https://www.youtube.com/watch?v=V6ypRbPzoPM&feature=youtu.be
https://www.youtube.com/watch?v=3mri2pbs_PM&feature=youtu.be
https://www.youtube.com/watch?v=dzhMQm-kO2I&feature=youtu.be
https://www.youtube.com/watch?v=dzhMQm-kO2I&feature=youtu.be
https://www.flickr.com/photos/parksjd/14608061324
https://www.flickr.com/photos/parksjd/

Upside Down & Forced Perspective

Don’t feel like a bully—forced perspective doesn’t mean you’re forcing anyone into looking at your photo a certain way. Rather, it refers
to the manipulation of perspective in your shot, whereby you make objects appear closer or farther depending on their placement before
the camera, and not according to reality. So while you’re not forcing the viewer per se, you’re still tricking them to see exactly what you
want them to see. Think of it as an optical illusion—a magic trick any photographer can pull off.

While this trick seems easy sometimes (“Hey, look at me! I’'m holding up the Leaning Tower of Pisa!”), that kind of gag can get pretty tired
pretty quickly. The real trick behind the trick is creativity —show us something truly original.

The viral trick

Don’t discount the power of this genre: using
forced perspective techniques in landscapes and
cityscapes can set your work apart dramatically,
foremost because of its inherent virality. If you
manage even just one of these types of shots,

it can do much more for your personal brand
online than any regular landscape or cityscape
shot. Clickability and shareability count for a lot
these days.

You don’t need to establish yourself as a

trick photographer, either. Dlversifying your
photographic portfolio can increase your appeal
without limiting your audience. You just need

a lucky break. In any business—but especially
photography—that all boils down to how many
options you give yourself.

Upside down? by Matthias.



https://www.flickr.com/photos/mattuschek/5489224435
https://www.flickr.com/photos/mattuschek/

Turn that town upside-down

Here’s a quick tip: in landscape and cityscape
photography, an easy and captivating style

of forced perspective is an upside-down
composition. These types of photos often get
widely shared online when done right, because
they’re still novel without seeming like a novelty;
the perspective can add meaning to a scene and
catch one’s attention more easily.

To do these types of shots, all you need, really, is
a good opportunity: grounds that look like skies
are great, and city reflections (think bays and
rivers) work perfectly to achieve this effect. But
to make it easier on yourself, you may want to
invest in a tripod that can offer secure upside-
down shots: some poles can be inverted so the
camera hangs between the legs. To the tripod’s
credit, it’s actually much easier to balance the
camera this way without shakiness; on the
downside, you’ll have to basically lie down on
the ground to try and see through the viewfinder,
unless you have a movable display screen. Or
the easiest method is to take the shot normally
and then flip it in post-processing.

Keep your eyes open

Above all, the only way to truly navigate through
optical illusion photography is by keeping your
eyes open for opportunities. Look for natural and
manmade mirrors, reflective surfaces, and any
objects that can be manipulated through the lens.
This technique isn’t like basic photography —you
can’t just hike to a pretty mountain and take a
few snapshots. With this very deliberate style,
you’ve got to hunt your locations out, keep your
mind sharp and stay on the lookout.

174, 1/640 sec, ISO 100, 24mm, upside down by Thomas Leth-Olsen. 175, 1/800 sec, ISO 800, 30mm, [39/365] How do you see the world?

by Sander van der Wel.
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https://www.flickr.com/photos/christiaantriebert/2975069958/
https://www.flickr.com/photos/christiaantriebert/
https://www.flickr.com/photos/thomasletholsen/9468398890
https://www.flickr.com/photos/thomasletholsen/
https://www.flickr.com/photos/jar0d/5255141089
https://www.flickr.com/photos/jar0d/

We haven’t talked much about fisheye lenses in this book.

That’s unfair to the little fellas. While many professional
photographers might scoff at the mere mention of them, fisheyes
can be a remarkably innovative tool for capturing weird and wild
perspectives that many of us rarely get a chance to see.

For those unaware of what a fisheye lens does, you’ve still likely
seen the effects of one: they are a type of ultra-wide angle lens
that distorts reality by bending it spherically, creating a panoramic

Horizon placed in center to minimize fisheye distortion. Santorini Fisheye View by Pedro Szekely.

or hemispherical result. Fisheyes are great at capturing extremely
wide shots—panoramic angles, up to 180 degrees—but only at the
expense of bending the ends of the image up and down into a circle.

For cameras with a 35mm sensor or film, a typical circular fisheye
lens might have a focal length of 8mm to 10mm. Full-frame lenses
have slightly longer focal lengths, usually 15mm to 16mm. This
makes them super-tight and compact—an easy addition to a set
of heavier-duty lenses.
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https://www.flickr.com/photos/pedrosz/8437680440
https://www.flickr.com/photos/pedrosz/

Minimize distortion with this one
simple trick

If you’re devotedly reading this book in order,
you might recall that, in an earlier chapter on
horizon lines, | mentioned that you should rarely
place your horizon in the center of your image.
(Rule of thirds, remember?) Well, when it comes
to fisheye, that’s the trick: ignore that rule.

When dealing with landscape photos via fisheye
lenses, placing your horizon in the middle of
your frame is actually the best way to minimize
distortion. In some cases, of course, you’ll want
to emphasize that distortion, but to achieve

a simple panoramic-style image with as little
forced manipulation as possible, a central
horizon line helps to keep the image looking at
least a little normal.

If you want to see what | mean, just grab your
fisheye lens and look through your camera’s
viewfinder. Tilt your camera up and down: the
farther the horizon line is from the center, the
greater the distortion.

Don’t fight the fisheye

Of course, you may not want to minimize
distortion—after all, you’re working with a
fisheye lens for a reason. Distorted images can
be great eye-catchers, too, especially online,
where viewers do a double-take while trying to
figure out what exactly the original image once
looked like. Our minds tell us that something
isn’t quite right with the scene, and we spend
time trying to figure it out.

The farther the horizon line is from the center of
the frame, the more curved the earth becomes.

Horizon placed off-center to maximize fisheye distortion. Fisheye Sunset 2182 by Kain Kalju.

Play around with this. Especially if there’s
something above or below the horizon that can
take up the inside of the circle, curving the frame
can be a great creative tool for capturing a wide
visual landscape.

Long exposures with fisheyes can also be a
great deal of fun—in a city, zooming headlights
will turn into blazing highlights running circles
around your image. Use this movement to your
advantage, but test out a few angles if it’s your
first time; experimentation is crucial, which
includes a few safety shots in case the long
exposures don’t work out. As with any long
exposure photography, patience and a sturdy
tripod are essential; you can refer back to any of
the chapters that deal with long exposures to get
a sense of how this might work.

Dive into fish territory

As | mentioned above, a lot of straightlaced
photographers may roll their eyes at the
thought of using a fisheye lens. But aspiring
photographers depend on new experiences

to understand the full spectrum of their craft.

I wouldn’t recommend a fisheye all the time—
but when it comes to the occasional eye-
catching landscapes and cityscapes, it’s a great
tool to have.

If you’re wary of buying one (with good reason—
they often cost well over $1,000), try a rental for
a weekend. Just testing it out can be a lot of fun,
adding a few variations to your portfolio, and it
will certainly help open up your mind to a whole
new world of possibilities.
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https://www.flickr.com/photos/kainkalju/5873974669
https://www.flickr.com/photos/kainkalju/

Shallow Depths
In Landscapes
& Cityscapes

For most of this book, any time aperture has
come up, I’'ve advised that you go deep. As a
rule of thumb, a deep depth of field is crucial
to landscape and cityscape photos—it allows
you to keep everything tightly in focus, and
reduces the odds of any part of the image
being blurred or shunned.

For just this brief chapter, let’s pretend | never
said that.

This is either an unconventional trick or

a full-on, full-time preference for some of

you. The fact is, shallow shots can still work

in landscape or cityscape scenarios. You

just need to frame them differently. Some
landscape photographers have enjoyed great
success by incorporating compositions relying
on shallow depths of field. The only technical
“trick” is a very wide aperture—a low f-stop—
and a keen eye for this style of photography.

172.8, 1/160, 1SO 100, 28mm. House-0-Ivy by Ricardo Camacho.



https://www.flickr.com/photos/65487073@N03/6447087879
https://www.flickr.com/photos/65487073@N03/

Keep it subtle

These types of shots often work best when you
focus on a subtle subject in the foreground, and
blur a visually impressive background. You don’t
want your backdrop mountain to look like a
mistake you messed up the f-stop on—you want
your image to look deliberate.

Deliberation is the real secret ingredient here. If
your shot looks sloppy or accidental, the effect
is ruined. You want to create a particular sense
of mystery —like you’re offering something to the
viewer, but not quite giving them what they want.
Make them stare at your image for longer, and
they could get absorbed by it.

If your background image is clear-cut, then
you’ve got to use your foreground focus for a
good reason. Don’t arbitrarily focus on a tree in
front of a waterfall unless that tree is something
truly special. Even if the background is clear,
your logic won’t necessarily be.

Keep it surreal

Sometimes these shots offer a touch of
surrealism to the shot, which can create an
affecting ambience. By keeping the audience on
edge, or somewhat out of the loop—blurring an
image in the background, or even (if you do it
right) the foreground—can lead to deeply artistic
imagery.

For cityscape photographers especially, knowing
what types of structures produce what types of
bokeh is essential to shooting this way. Use that

higher-end lens and find a brightly lit building at
night to turn lit-up windows into star-like blurs,
or transform a background of trees lining a
street into a foggy forest behind a parking meter.
We’ll discuss bokeh more in depth, including its
variations and the best ways to capture it, in the
next chapter.

As with many of the styles of photography in
this section of the book, shallow depth of field
images are not in the traditional style. Nor will

/4.5, 1/60 sec, ISO 1000, 22m. Hudafoss, Iceland by Claudia Regina.

it likely become your go-to style of shooting.
But this entire section is about diversification,
and blending multiple tricks and styles is
how to get there. Knowing how to optimize
certain situations is the hallmark of a great
photographer.


https://www.flickr.com/photos/claudiaregina_cc/9369200257
https://www.flickr.com/photos/claudiaregina_cc/

Bokeh In
Landscapes
& Cityscapes

We’re now going to enter a realm

often dominated by portrait and macro
photography: beautiful, blurry bokeh. But it
is also a powerful tool for the shining lights
of cityscapes.

As a quick recap, bokeh is the composition
of polygonal shapes out of specks of light

in the background. Some bokeh is soft
and round; others are hard and hexagonal.
The quality of a high-end prime lens is
often defined by the quality of its bokeh.
By creating an ambiguous background,
incorporating patterns and textures into
your imagery, you’re opening up your
viewer’s mind to limitless possibilities.
Audiences tend to appreciate the
technique, too, because of how great it is
to see something new, a piece of their city
ablaze in bokeh.

171.8, 1/40 sec, ISO 800, 24mm. 42nd Street by Owen Byrne.



https://www.flickr.com/photos/ojbyrne/6119000933
https://www.flickr.com/photos/ojbyrne/

Measuring bokeh

Before we delve into the art behind bokeh,
let’s talk about the math behind it. As a basic
measurement: distance + light = bokeh.

We’ll start with distance. As we know, the closer
your camera is to the subject, the shallower the
depth of field will be behind the subject. So if
you’re shooting a street sign in front of a flashy
billboard, the distance between you and the
street sign will affect how the backlight appears.
Taking a few steps forward or backward will
affect the style of bokeh.

The next factor is light. Background light can be
any variety of things: sunlight breaking through
tree branches, passing cars’ headlights, high
rise reflections in rivers. The light source doesn’t
need to be direct in order to create bokeh; it can
come from virtually anywhere.

Bokeh through the lens

Lens quality is a major factor in bokeh. To best
achieve this effect, you’ll need a high-quality
lens capable of very low f-stops—f/1.4 or lower.
Some lenses that specialize in wide aperture
ranges even allow you to adjust your bokeh
style: extremely wide apertures produce softer
bokeh, and narrow apertures define the bokeh a
bit firmer.

But it bears mentioning that expensive lenses
capable of high f-stops aren’t essential here.
Great results can be achieved with more
common lenses, depending on how you set up
your shot, and how far you distance your subject
from both yourself and the background.

You can see how street lights turn to bokeh when blurred, Navigli by Alessia Damone.

Small details by Asparukh Akanayev.

Artistic possibilities

Bokeh depends on much more than this, of
course. Shapes, colors and textures affect it just
as much. Cityscape bokeh is a great example—
the combination of yellows, blues and reds

that invariably appear at night make the perfect
backdrop for a romanticized view of city streets.
Matching gentle bokeh in the background with
a richly textured foreground is an excellent
combination of soft and rough; getting creative
with low angles (think sewer grates or cracked
sidewalks) can open up possibilities also.

The next chapter will deal with another aspect of
creative bokeh: controlling the shapes artificially,
with a surprising arts-and-crafts project.


https://www.flickr.com/photos/timetoewill/8614359294
https://www.flickr.com/photos/timetoewill/
https://www.flickr.com/photos/aakanayev/9214755049
https://www.flickr.com/photos/aakanayev/

Shaped Bokeh

Want to see a real trick? Unlike some of the in-camera distortions we’ve dealt with so far—forced perspective, star trails, long
exposures—this next one takes a fair bit of time and preparation to pull off. The upside? You also wind up with a totally original,
unreplicable shot. It would be far more trouble than it’s worth to work this one out in Photoshop.

Changing the shape of your bokeh—transforming those faint background blurs into stars and hearts, for example—involves good old-
fashioned cutting and pasting. In fact, it’s possibly the only photographic technique that calls for scissors and tape. But before we get
too far into the specifics, let’s go over the bokeh basics.

Why is bokeh round?

Bokeh is basically round because apertures are
round—the physical sliding mechanisms that
control the size of your lens opening open it up
into a rough-edged circle. Depending on both
the distances between your camera and the
subject, and your subject from its background,
“natural” bokeh might look like anything from

a blurry circle to a slightly more jagged blurry
circle. But never anything else.

That is, unless you want to make it something
else.

You can create shaped bokeh by adding a thick
piece of paper to the front of your lens and
cutting a shape in the center of it, then taping it
to the lens itself. It’s a bit crude to look at, but it
works wonders. Cut a heart, and your bokeh will
be shaped like hearts; cut a star, and you’ll be
seeing stars.

/1.4, 0.5 seconds, 50mm, ISO 200, Heart shaped bokeh 1 by louri Goussev.



https://www.flickr.com/photos/igoussev/3957914071
https://www.flickr.com/photos/igoussev/

How to shape your bokeh

First, you’ve got to decide on a shape. It’s easy
to start simple, but feel free to get creative if you
like—check out Clipart, wingdings or emoticons
for inspiration.

Next, print the shape out on a piece of paper.

It may take a few tries to get the size right.
When you cut it out, it’s got to be exactly in the
center of your lens. Because lenses are perfectly
centered, your cutout will have to be also.

When you’ve got a good printout, it’s time to cut
the image out. You’ll want to make sure the cut
is precise, because you want as little extra light
coming through as possible. Stick to the dotted
lines.

Next up, tape the paper to the front of your
lens, or attach it to a lens filter that you can snap
on. Spare UV filters are perfect for this—the kind
some photographers use simply for protecting
their lens, rather than affecting the light. Place
the filter over the image and trace a line on the
paper, then cut the circle out and attach it to the
filter front.

(Some bokeh shapers prefer to create a full-on
paper cylinder that can fit over the front of your
lens, which is worthwhile if you think you’re
going to return to this trick more than once.
You can swap out your cutout front and reuse
the cylinder as many times as you need —after
you cut out your circle, you simply cut another
rectangle and tape it around the outside of your
circle, thus creating a cylinder to fit over your
lens.)

/1.4, 1/10, 1ISO 200, 50mm, Self portrait through custom shaped bokeh widget by louri Goussev.

Lastly, all you need to do is find a good lighting situation. (Be sure to use a wide aperture to

get the strongest bokeh effect.) We discussed what kind of lighting situations to look for in the last
section—headlights and streetlamps are great opportunities in cityscapes. While hearts and smiles
are nice, you can try creating thoughtful visual links in your work, like transforming the brightly lit
windows of high rises at night into actual stars.

Want to see it in action? Here are three great videos to take you through the process,
step-by-step:

How to Make a Bokeh Lens

Make Your Own Bokeh Frequent Use Kit

Shaped Bokeh Demonstration



https://www.flickr.com/photos/igoussev/3957912301
https://www.flickr.com/photos/igoussev/
https://www.youtube.com/watch?v=cFM2g6_N5Fw&feature=youtu.be
https://www.youtube.com/watch?v=H5jjr_vKruU&feature=youtu.be
https://www.youtube.com/watch?v=Crj3AZT69m0&feature=youtu.be
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Double Exposures

Remember film cameras? Every time you took a shot, you’d have to advance the film strip to the next frame, until you ran out at around
24. If you didn’t advance the frame, you’d be opening up the shutter to capture two images on a single frame of film, doubly exposing it.
The overlap could look cool if composed correctly, or it could look totally wonky and wrong.

That’s the essence of double exposure, a technique that has, since the exit of film cameras, taken on a second life in digital photography.
Obviously, digital cameras don’t work the same way—but Photoshop can make up for that, and some higher-end digital cameras
themselves offer a “multiple exposure” function.

So regardless of whether you’re using Photoshop or doing it in-camera, we’re going to explain the process here.
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https://www.flickr.com/photos/katq88/3725718223
https://www.flickr.com/photos/katq88/

With a digital camera

First, you’ve got to find the multiple exposure
feature. It’s not very common, so you might have
to dig deep for it—spend some time skimming
through your camera’s options menu.

From there, you’ll find a few sub-menus you
can choose from. I'll use the Canon 5D as an
example—if you have any other model or brand,
the specific wording might be different, but

the gist of these should remain the same. I'd
recommend this route:

1. Choose the Function / Control setting

2. Under Multiple Exposure Control, choose
Additive

3. Stick with two exposures (multiple exposures
are fun, but start with double to get a feel for
it)

4. When choosing a location for source images,
choose All Images

5. Choose Continuously under Continue Multiple
Exposures

Also, there’s an optional option for selecting a
previously taken photo as your base image. If
you don’t, you can take two new ones to merge
together.
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Using Photoshop

If your camera doesn’t have the multiple
exposure function built in, there’s always
Photoshop. Photography puritans will decry
this method as “less authentic” since it’s not
technically a double exposure, and that’s
fine—let them doubly expose their film slides

in darkrooms and claim the authenticity title.
They are, technically speaking, not wrong, since
anyone using Photoshop isn’t actually exposing
film twice (or thrice, etc.). But there’s never a
need to be that pedantic. If the image works, it
works—and Photoshop can still make it work.

Also, it’s wicked easy. Here’s how to do it:

1. Open two photos as layers in Photoshop

2. Decide which one you want to be the base
layer, and overlap it with the second image

Tongwell Lake by Brian Tomlinson.

3. Set the top layer’s opacity to 50 percent—and
you’re theoretically done!

4. If that doesn’t produce the blending effect
you want, reverse the opacity to 100 percent
and go to Layer Options, find Blending and
choose something like Screen Blend

5. Toy around with the settings if you find a style
that fits your image better

Sounds easy, right? | suspect that’s the reason
such hardcore darkroom enthusiasts scoff at the
thought—perhaps they’re jealous that modern
photographers can achieve the same effect
easier now than ever before. Of course, the
Photoshopped version will look a bit different;
film does offer a certain sort of magical quality
that certain digital reproductions can’t match...
yet. But for experimenting with a new trick, post-
processing works fine.


https://www.flickr.com/photos/brian_tomlinson/12502734115
https://www.flickr.com/photos/brian_tomlinson/

Tips on double-exposure photography

Sure, double exposures can work with really
anything—but the worst of them feel random. As
with forced perspective, light painting and even
basic photographic composition, you’ve got to
make sure your images are shot deliberately.
When deciding what you want your shots to be,
think ahead. Some images work better overlaid
than others. Don’t just overlap a mountain onto
a skyscraper and call it symbolic. Think about
how the images will blend, and what that blend
will say.

Some of the most stunning double exposures
come from primary shots silhouetting a subject
against a nearly all-white background. The
secondary shot isn’t as critical to pose this
way —it’s the fact that the initial one is made
from stark black and white, and is easy to
overlap with another image, since the white
will allow the second image to take over. If one
is minimalistic and the other complex, it often
works better than overlapping two frantic shots
into something unrecognizable.

Iceland Double Exposure by Richard P J Lambert.

That said, the two shots can be whatever you want them to be. Double exposures are all trial and
error. Most photographers find a style they thrive in through experimentation—some will tend towards
overlapping nature with technology, or humans against a blank-slate background, like the sky or sea.

Want to see how to create double (or multiple) exposures in action? Then check out these
videos:

In-Camera Digital Double Exposure Tutorial

How to Make a Double Exposure in Photoshop
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Slow Shutter Zoom

Photography is stillness —this is obvious. But sometimes, at its most daring, photography
doesn’t capture a moment so much as a movement. Blurred bodies walking through

a long exposure are one thing; headlights zooming through a city night are another.

But what about a landscape moving on its own?

This technique is called a slow shutter zoom, or “racking the lens.” It’s the result of
shifting your lens’s focal length during a long exposure —taking the viewer on a ride
through the process of a long shot. The results can be unbelievable, and are totally
achievable without the use of any post-processing.
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We are setting a long exposure about 8 seconds in this. Keeping the standard zoom lens at Tele mode and then just after clicking the shutter
button, we turn the lens to wide mode. Keeping in mind that exposure at wide mode is more than the tele. This gives the explode effect to the
image. /13, 8 seconds, IS0 100. Click n Zoom by Yogesh Mhatre.

Zooming in on the technique

The most important rule is to keep your tripod
sturdy. Use one that can be weighted down from
the center. Of course, as with any long exposure
shots, stillness is imperative; the difference here
is that you’ll be handling and moving the camera
lens. It’s not like a long exposure shot with a
self-timed or remote shutter release; this is you
pushing and holding the hardware. Make sure it
doesn’t move.

Next, set up your camera for a long exposure
in a low-light situation. Compose and focus
your shot like a normal long-exposure shot.
(We've gone over this in past chapters—feel
free to revisit those for tips on long-exposure
photography.)

Once you press your shutter release, slowly
zoom in or out during the length of the shutter’s
opening. Sounds easy—if it’s a three-second
exposure, you’ve got three seconds to zoom in
or out. This will take lots of trials and even more
errors: it’s best if you can time out your exposure
to match the time it takes to completely zoom
your lens in or out, taking into account the fact
that you might want to stop and pause for effect
at some point.


https://www.flickr.com/photos/mhatrey/6762658193
https://www.flickr.com/photos/mhatrey/

Tips on racking

Try to make the zoom itself as smooth as
possible, otherwise you’ll find “bumps” in
your final image where the light is stronger on
the parts you lingered on. On the other hand,
sometimes lingering can create a worthwhile
effect, especially if you want to emphasize the
reality of a photograph: for example, if you set
your camera to an eight-second exposure,
you could leave your camera alone for the first
four seconds (a self-timer would be a good
supplement here), and then zoom through the
last four seconds. You can experiment with
the parts of the zoom to emphasize different
elements.

Also this technique works best in dim lighting
scenarios that allow small rays of light shining
into the scene—think of lights from a distant
skyline or sunlight beaming through clouds.
They’ll streak outwards from the center of your
image to all four corners, creating a very cool,
even futuristic “hyperdrive” effect.

Keep in mind that whatever is centered in your
frame will be the least affected by distortion.
The center of your image will always be the
sharpest, and all the blurred light streaks will

lead your viewers eyes to the center like leading

lines—unless you choose to crop them out.
Compose the image properly and remember
what you’re focusing on, and how you’re
using the technique to deliberately guide your
audience towards something interesting.

No zoom? No worries

If you want to try the effect but don’t have a zoom lens (maybe you’re shooting with a prime, for
example), you can achieve the same effect by physically moving your camera forward and backward.
The trick here is to avoid also moving your camera left and right—the whole thing will just end up
looking blurry. Using a moving platform or vehicle (like the front window of a train), the car will propel
the camera forward and can produce a similar effect.

If you’re not in a train, you can still get inventive. Dollies and skateboards, if the surface is smooth
enough, can achieve a similar result—and possibly some very cool perspectives. As always,
experimentation is key.

1720, 4 seconds, 1SO 200, Zoom effect by Photos by Angela.
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Infrared Photography

The first time | saw an infrared landscape, | was blown away. It’s a marvellous sight—dramatic clouds, surreal colors, unnaturally even

lighting. These images seem both dreamlike and hyper-realistic, a fantasy version of our own world. A bizarro world. And only dedicated
photographers have access to it.

Infrared photography gives artists the chance to show their audiences a view of the world that’s literally impossible to see otherwise —
infrared light is outside the spectrum of light our eyes can detect. It’s entirely up to the film or image sensor to capture it, which is a very
empowering thought for the technologically minded. In this infrared light, cameras help us better understand the world we live in.


https://www.flickr.com/photos/imagesbywestfall/8669456289
https://www.flickr.com/photos/imagesbywestfall/

A brief history of infrared photography

Infrared light is as old as light itself, but humans’
interaction with it only dates back around 200
years. It began with a German-born British
astronomer, Sir Frederick William Herschel, who
in 1800 noticed that certain colored glasses
passed more heat from the sun than others.

He tested his theory out by measuring their
exact temperatures and noticed that, as the
thermometer moved from the violet spectrum

to red on the opposite end, the temperature
increased. When he shifted the thermometer
beyond the red glass, the heat continued to rise.
Despite the area being invisible to the human
eye, that section of light became what we today
know as infrared light.

Infrared photography wouldn’t come about until
1910, when the Royal Photographic Society
published a journal edition featuring infrared
photos by American physicist Robert Williams
Wood. Wood used experimental film and very
long exposures, and sensitized his own photo
plates. It wouldn’t be until 1930 that Kodak
would produce actual infrared film, and not until
the 1960s that infrared photography as a style
even took off, after musicians like Frank Zappa
and Jimi Hendrix used the effect on their album
covers.

Since the rise of digital photography, though,
infrared has been on the decline. In 2007, Kodak
discontinued its production of the film, and

rolls today cost between $10 and $20 each—a
telling fact about a niche photographic style in
contemporary times.

Three modern methods for infrared
images

There are three ways of capturing infrared
photos: With a film camera, buy a roll of infrared
(IR) film; with any SLR, buy an IR lens filter; or
convert your DSLR for infrared use. Here, we’ll
go through all three.

Method 1: Infrared Film

While most of this book has focused on digital
techniques, hardcore infrared enthusiasts will
know that buying a 35mm IR roll of film is the
way to go. Most camera stores sell them for
around $10 or $20, and even if they don’t carry
them in stock, stores are often able to order
them if you specially request it.

Developing the film, however, is another story.
Not all photo labs can process IR film, although
most can send the rolls out to a lab that can.
Depending on the location of the lab and the
priority of your prints, this could take up to a
week or two to get back.
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Method 2: IR Filters

Regardless of whether you shoot analog or
digital, a lens filter can replicate the IR look
perfectly. The filter you’ll want to buy is called a
Circular IR filter. Like any regular UV or polarizing
lens, an IR filter can twist on and off of the front
of your lens easily.

An IR filter actually blocks visible light from
passing through the lens, allowing only IR light to
reach the camera’s sensor. The one side effect is
that you’ll need to use extremely long exposure
times, to compensate for the darkness caused
by shutting out all that visible light. Most digital
cameras have an internal filter to remove most
infrared light, so between that filter blocking

IR and the attached lens blocking regular light,
you’re basically shooting darkness. Time to bust
out that tripod again.

INFRARED (R72)

The Popular Hoya R72 Lens Filter for Infrared

Don’t be surprised when you open up your IR
filter for the first time and it looks almost black.
Even after you swivel it on, the view of your
image from the viewfinder or screen will be
black. This would make composition tricky —
except that most SLR lenses come equipped
to work around this problem. Look through
the viewfinder for a little red mark—maybe a
line, diamond or dot—that’s beside the regular
white focus mark. The red symbol is meant

to help photographers check their focus and
composition specifically in IR situations.

As for composition, you’ve got to remove the IR
filter. Just twist it off to compose and focus your
image as normal, then switch to manual focus
and re-attach the IR filter. Here’s the tricky part:
you’ll have to focus the lens partway between
the current visible focus and the infrared mark.
(Reasoning: in many lenses, infrared light has a
different focal point than visible light.) For any
lenses that don’t include infrared focus marks,
you’re out of luck; focus becomes more of a
guessing game. You can fire off a photo then
check the result closely on the LCD; if you
detect any unwanted blur, adjust the focus ring
slightly and try again until you have a sharp
result.

But the upside to all this trial and error? Cost.
For roughly $50, an IR filter is not a bad deal;
even if you’re shooting film, the cost of an IR
filter is cheaper than three or four rolls of IR film.
It’s a solid, flexible and common investment.
Some of the most popular filters come from
Hoya, a Japanese filter manufacturer; their R72
and RM9O0 filters are among the most popular
and highly rated in the field.

Method 3: Converting a DSLR

The last method is simultaneously the most
flexible, expensive, complicated and ultimately
convenient way to shoot IR: convert your DSLR
to shoot exclusively that style. This takes time
and money, but often yields the best results.

To convert your DSLR, you’ll need to remove the
internal filter | mentioned earlier—the one built
into your camera that blocks infrared light. This
filter can be substituted for one that only allows
in IR light. It doesn’t change the functionality

of your camera at all—except that all of your
shots will be infrared, and it’s possible that your
camera will never go back to normal. (Certainly
not easily, or cheaply, or within a manufacturer’s
warranty.) You’ve been warned.

If you’ve got a spare or old DSLR that fits the
bill, there are several companies that can do
it for you. For guaranteed results, it’s best

to choose one with a solid reputation, like
Lifepixel —the whole process should cost
between $200 and $500, depending on your
camera body.

Of course, you can bypass paying those several
hundred bucks by taking the DIY route, but
you’ll still have to buy a kit that shows you how.
If you’re familiar with electrical handiwork this
shouldn’t be too hard; if you’re a novice, it’s not
recommended.


http://www.lifepixel.com/

Finding an IRresistible lens

Good news for budget photographers: expensive
gear doesn’t always translate to better shots in

this field. Lenses are hit or miss when it comes to
IR. There are a few common issues that creep up:

1. Depending on the internal coating of your
lens, the IR light might cause some suddenly
visible reflections, called hotspots. They’ll
typically appear in the center of your image,
and are the result of certain coatings not
being transparent to infrared wavelengths.

2. Some lenses, shooting in infrared light, are
more susceptible to flaring than others.
Watch for this effect when shooting, and use
basic maintenance to avoid it as much as
possible: keep the lens and filter clean, and
use a lens hood whenever possible.

3. You should start paying much closer attention
to white balance. Infrared light is primarily
collected in the sensor’s red channel, which
will make your images appear more red than
normal. An easy way around this: set a custom
white balance. All cameras differ slightly in this
arena, so try setting the custom white balance
on a variety of objects (such as green grass or
a gray or white card) to familiarize yourself with
how your camera will behave.

Of course, your best bet is to avoid lenses that
others have reported as being problematic for
infrared in the first place. Here is a list of them,
care of Lifepixel. The list isn’t too large—most
lenses don’t have a problem with IR, or, if they
do, they suffer a minute enough version of the
problem that nobody would really notice.
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Post-processing infrared images

Can’t get the red out of your image? It’'s a
common problem. Some photographers
embrace it; others would rather not all their
landscapes look like images drafted from hell.

That’s where Adobe comes in.

First, | need to stress how important it is to be
shooting these in RAW. You can get the most
out of editing your infrared photos with a large
file size.

Post-processing out the red, DSC01438 and DSC01440 by Mike Lewinski.

The key adjustments in Lightroom are the
Temperature slider and the Tint slider. Wiggle
them back and forth to avoid changing the
depth of your blacks and whites or the levels of
contrast or brightness. You should be able to
eyeball at what point you achieve a tone that fits
your image.

If you’re working with Photoshop, use the DNG_
profile editor, or else stick with Levels, the Hue
and Saturation sliders, and the Channel Mixer.
You won’t need to go overboard by using all of
them, but they’ll change the image in different
ways, and experimentation is the only way to get
the right color.

Step outside with these external links

If you want a step-by-step tutorial for processing
infrared in Lightroom & Photoshop, | can’t offer
anything better than these comprehensive
guides:

m Basic Infrared Editing in Photoshop

m Infrared Editing Using Both Lightroom &
Photoshop

m Advanced Infrared Processing in Photoshop

And if you’re looking for some more reading, |
recommend these pages and websites, which
are basically hubs for IR enthusiasts:

m Lifepixel Info & Consulting for Camera
Conversions to Infrared

List of Good and Bad Lenses for Infrared

m Lenses to Avoid for Infrared Photography

List of Good and Bad Cameras for Infrared

DIY Tutorials for Converting Cameras to
Infrared Listed by Make & Model

Photography Tricks 52


http://www.adobe.com/support/downloads/detail.jsp?ftpID=5493
http://www.adobe.com/support/downloads/detail.jsp?ftpID=5493
http://www.lifepixel.com/tutorials/infrared-photoshop-basics
http://photofocus.com/2014/06/15/processing-an-infrared-image-using-lightroom-and-photoshop/
http://photofocus.com/2014/06/15/processing-an-infrared-image-using-lightroom-and-photoshop/
http://photography.tutsplus.com/tutorials/an-in-depth-guide-to-infrared-photography-processing--photo-9540
http://www.lifepixel.com/
http://www.lifepixel.com/
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http://dpanswers.com/content/irphoto_sensors.php
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https://www.flickr.com/photos/ikewinski/6953757134/in/set-72157631972513152
https://www.flickr.com/photos/ikewinski/6953759462/in/set-72157631972513152
https://www.flickr.com/photos/ikewinski/

Tilt-Shift

il Z

Real tilt-shift with the Leica M Monochrom and a Canon 17mm tilt-shift lens. Lines, Light, Shadows, and Reflections by Andreas Overland.

Ever see a photo that makes reality look like a toy? Mountains become Play Doh;
buildings smallen and condense. The perspective of the entire world is distorted
into something so miniature that it’s simply unreal. That’s tilt-shift photography:
using camera movements to selectively focus on a landscape or cityscape,
creating a seemingly miniature scenario.

True tilt-shift photography requires the use
of special lenses that are able to both—
wait for it—yes, tilt and shift. (It’s shocking
how original the people who invent these
lens names are.) Canon currently has four
tilt-shift lenses on the market, while Nikon
offers three, and a host of third-name
brands fill in the gaps.

Tilt-shift photography is another one of
those niche genres that catch viewers’
attention for surreal, gripping imagery.
(Remember forced perspective, spherical
panoramas and light painting? It’s like
that.) But it’s especially common in
landscape and architectural photography
to control the perspective of the entire
scene and capture a wider shot than
normal lenses are capable of.

nex Tilt-Shift system by Andrew Xu.



https://www.flickr.com/photos/andreasoverland/8537360802
https://www.flickr.com/photos/andreasoverland/
https://www.flickr.com/photos/andrew_xjy/6948538693
https://www.flickr.com/photos/andrew_xjy/

Photoshop tilt-shift effect. /5, 1/320 sec, IS0 400, 17mm. Real models by Kenny Louie.

Tilt, shift, repeat

How does tilt-shift photography work? With the right lens, it’s fairly easy. First, the shift: the shifting lens movements allow the photographer to control
where the lens’s imaging circle sits in relation to the camera’s sensor. The key phrase there is “in relation to” —that alterable relationship means that the
center of the lens’s perspective doesn’t correlate to the center of the image’s perspective.

Now let’s talk about tilt. Recall how every photo has a plane of primary focus—use a prime lens shooting along a flat surface and you’ll see it easily. Well,
tilt movements allow the photographer to tilt that in-focus plane so that it’s not necessarily perpendicular to the axis of the lens. This forces the depth of
field to be wedge-shaped, while its width increases with distance from the camera. That means the tilt effect doesn’t necessarily increase the depth of field,
but it lets the photographer choose the focal point of the depth of field to better suit the subject matter.


https://www.flickr.com/photos/kwl/2683012846
https://www.flickr.com/photos/kwl/

If you can’t make it, fake it

Can’t afford a tilt-shift lens, or just plain don’t want to buy one? Photoshop
has made it possible to fake tilt-shift photography with decent accuracy—
in fact, the fake has become arguably more popular than the authentic
product. (I'll concede here that it's impossible for Photoshop to re-create
tilt-shift photography completely, but the effect is still pretty close.)

Here’s how to do it:

1. Open your photo in Photoshop. Choose an image that lends itself well
to looking like a miniature model—something from a bird’s eye view,
with a lot of variously sized objects like people, cars and buildings. For
example, I'll be using this aerial shot of Shibuya Crossing in Tokyo for
this tutorial—feel free to download it and follow along if you like.

2. Create a duplicate layer of the background by selecting Layer >
Duplicate Layer.

3. On the top layer, apply a Lens Blur filter by going to Filter > Blur > Lens
Blur. Use a radius of anywhere from 20-40. For mine, I’'m using 34.
Then click OK and watch the image blur.
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4. Stay on the top layer and add a Layer Mask.

5. Select the Gradient tool from the toolbar, and change the gradient style
to “Reflected Gradient”.

6. Select the layer mask. Click and drag the gradient tool across the area
you want to be in focus. For this example, I’'m applying the gradient over
the intersection where the people are. It may take a few attempts to get
the gradient to focus the way you want—dragging the gradient doesn’t
come as naturally as using other tools in Photoshop—but you should get
it eventually.
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7. That’s it—now just save the image and show the world your work!

A quick note: while this method is the most common way to replicate a tilt-
shift effect, feel free to experiment with other blurring tools in Photoshop. |
sometimes like to apply different brushes on top of the gradient to fine tune
the blur, which can be a subtle but rewarding cherry on top of this miniature
cake.
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Multiplicity

Sometimes you need a subject in your shot, so you stand your
camera on a tripod, set its self-timer, and jump in yourself.
Sometimes you need multiple subjects, though—what then?
Simple: stand your camera on a tripod, set its self-timer, and jump
in yourself—again and again.

Multiplicity is an unusual trick because, unlike more subtle
effects, it’s blatantly obvious what’s going on: using software
like Photoshop, you’re manipulating reality to insert someone or
something into a shot multiple times.

&l
0,

Mask Edge...

This works well when displaying a series of movements: think of
a monk walking from a temple in a mountainous landscape, when
you’d take multiple shots to capture each stage of his progress.
You can literally see him every step of the way. It’s also a fun way
to portray solo travel—if you’ve just climbed a difficult mountain,
you might strike a few poses to convey all the different emotions
you went through while climbing up. At its best, this is a trick that
gets really creative and fun.

Photography Tricks 56



Laying multiplication on the table

This technique, like most others we’ve covered,
requires a tripod and absolute stillness during
the shoot. | recommend Aperture Priority mode
with a high f-stop, typical of landscape and
cityscape photos, to make sure that the depth
of field is deep and as much of the scene is in
focus as possible. The same goes for metering:
consistency is key, otherwise some shots might
appear dimmer or brighter than others, which
will throw the whole thing off balance. Manual
focus, too, is a good idea, so your camera
doesn’t automatically re-focus with each shutter.

Once your settings are in order, start snapping
away —either with your subject or a self-timer
turned on yourself. Take as many as you like
using as many poses as you like. The only
requirement here is that the tripod doesn’t move
and the lighting should stay the same for every
shot in a series.

Putting it all together

Once you’ve got all your shots, open them up as
layers in Photoshop. (As we went through in the
section on post processing, this is pretty easy to
do with either Lightroom or Bridge; you can also
use a script in Photoshop to load them as layers
by selecting Scripts under the File tab, then
choosing Load Files Into Stack.)

Once all your layers are visible and, well, layered,
follow these step-by-step instructions:

® Click on the topmost layer and apply a layer
mask by selecting Layer > Add Layer Mask.

m Select black as a color for a paint brush and
paint over the person in that layer. The person
should disappear, as if you were erasing them.

® |nvert the mask by pressing Ctrl + I. This will
make the blackened area visible, and vice
versa. You should be seeing double—two
people.

m Repeat these steps for every layer until you
reach the final layer. (The final layer should
stay as is, since there’s nothing beneath it.)

That’s all there is to it—a fairly simple Photoshop
trick. It’s a very cool technique for creating
action sequences, if you feel like spicing up your
landscapes with an unusual, almost supernatural
effect.

The shooting itself is what takes the longest, so
plan ahead if you're eager to give it a shot—the
Photoshop work shouldn’t take much time at all.
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Timelapse Photography

No landscape stands still. Trees are always moving, clouds always flowing, animals pop in and out; the sun sets and shadows shift.
Photography is great, but at this point it can’t show us the true nature of a landscape. Cities, too, are in a constant state of motion,
between pedestrians and cars and flickering traffic lights.

Long exposure are one way to deal with this movement. Time-lapse photography is another.

Time-lapse photography —basically photography in motion, a halfway-mark between photo and video—is much easier than it used to be.
That ease has bred a new generation of adventurous time-lapsers who’ve created limitless uses and varieties of time-lapse videos. But
don’t be daunted: sometimes the simplest ones are the most effective. We'll start with a simple one right now, but one that any DSLR

user should be able to handle.
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Your first time-lapse

For this one, you’ll need an intervalometer.
Whenever possible, I've tried to show you tricks
that use as few extra materials as possible,

but sometimes an intervalometer is just plain
necessary.

Start by setting up your trusty tripod and setting
your camera to Aperture Priority. Find your focus
area, then set the camera to manual focus to
avoid any re-focusing. You can shoot anything
here—a simple view from a window can work
beautifully. Connect the intervalometer and set

it to snap a photo every five seconds or so, and
leave it alone for a half-hour. When you stop the
camera, you'’ll find approximately 360 photos.

Transfer those photos to your computer and use
any standard photo editing software to compile
the shots into a video file. At 30 frames per
second, your video should turn out at around 12
seconds long.

Think about this for a second: you’re condensing
30 minutes of reality into 12 seconds. This isn’t
just a snapshot of a moment: this is a fluid
movement of life in motion, fast-forwarded.
That’s a very powerful tool.

Interrogating the intervals

The amount of time your camera takes between
snapshots should boil down to a matter of
preference rather than practice. Obviously,
taking a shot every 10 seconds will allow more
of the scene to change than if you took one
every three seconds.

As a general rule, | don’t stray beyond three to
15 seconds, and the deciding factor is motion.
Landscapes, for instance, which rarely see
drastic motion, can be caught once every 15
seconds or so—if anything, this helps the clouds
move along faster in the final product. In a lively
cityscape, though, I’d stick with shorter intervals
so nobody jumps ahead in the movie too rapidly.

RAW or JPEG?

Ah, this old debate again. Greater file sizes, or
faster loading speeds? Again the answer falls
more to your project than a definite right answer.
If you’re strapped for space on your memory
card, JPEGs will do fine; if you can spare the
space (or if you aren’t expecting over 500 shots)
then RAW files would be better. As always, RAW
files leave you with more flexibility to edit in
Lightroom or any other program.

Speaking of software...

Let’s talk programs. Time-lapses can seem
monumentally complex at first—don’t let it daunt
you. The key is always to start simple. There’s
always time for complexity later on.

Speaking of complexity: there are a lot of
software options for time-lapse videos. Like, a
lot. As you dive into this field you’ll learn the pros
and cons of each; for now, you can get a sense
of the field with this basic list:

m Adobe Photoshop - Quick and simple to use,
but suffers from limited functionality

m Adobe Lightroom - Great for batch editing,
especially with the Sync feature’s ability to
copy photo edits across a whole swath of
images; problem is, the presets take lots of
time to render into a video format

® Quicktime Pro - Regular Quicktime can’t do
this, so you’ll have to upgrade to Pro for it;
the upside is that it’'s among the most simple
pieces of software to create a time-lapse

m Adobe Premiere and Premiere Pro - It’s not
the most intuitive software on the market, but
Premiere can get the job done with a decent
amount of options

m Adobe After Effects - Recommended by
professionals, After Effects offers an amazing
selection of options and plugins to remove
flickering (more on flickering later), but it’s
both expensive and difficult for beginners

m Final Cut Pro - A go-to resource for
independent filmmakers, the Final Cut series
is fairly easy to understand on a basic level,
even if you’re primarily a photographer

m LRTimelapse - If you’re dedicated to the
cause, this high-end, high-niche option is
among the most widely used by time-lapse
professionals

m Photolapse - A more basic time-lapse photo
software, this one is free (awesome) but only
works with JPEGs (less awesome)



How to Construct a Time-lapse in Photoshop

For this time-lapse exercise, | was sitting on Treasure Island, overlooking the Bay Bridge leading into San Francisco. | took a few photos, but thought that
still images might not be enough to capture the full scope of what | was seeing. Propping my DSLR on a firmly rooted tripod, | focused on the bridge and
switched the focus to manual mode. Aperture Priority at /13, ISO 400, 36mm focal length. | set the intervalometer to five-second intervals. Aperture Priority
ensured that, as the sky fell darker and darker, the camera kept the fixed aperture but automatically lengthened the shutter speed to compensate for the

dimming light.

Between my starting and post-sunset finishing time, | let the camera snap away until | had 344 photos. Sticking with 30 frames per second, this gives me
enough for an 11-second time-lapse video. Here’s how it goes:

1. Load your photos into a Stack in Photoshop.
Go to File > Scripts > Load Files into a Stack

2. Select the folder your time-lapse images are
in and wait for the photos to be listed. It might
take a minute, especially if you’re working with
several hundred. Select them all and hit OK.

3. Once Photoshop starts stacking your photos
in layers, take a break—
this will take a little while depending on how
many photos you shot.
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. Once all the photos in your timelapse sequence are stacked into layers,

open up the Animation window by selecting Window > Animation.

. Select all the layers in your stack by selecting the first one, scrolling to

the bottom layer while holding the shift key, and then selecting the last
one. Then should highlight all of them.

. Once you have all the layers selected, find the Animation menu and

select the option to “Make Frames From Layers.” This will list out all your
layers as frames for your animation sequence.

. Make sure your photos are in the right chronological order, from start

to finish. If they’re in reverse (and it isn’t on purpose), you can find the
option to “Reverse Frames” from the Animation menu.

. Assuming your frames are in proper order, make sure there isn’t any

delay between them —under each frame it should say “0 sec.” or “No
Delay.” If it doesn’t, click on it and select “No Delay.”
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9. That’s all there is—now we’re ready to export. Select File > Export >
Render Video.

10. In the Render Video dialog box, set your desired export settings. | gave
mine a name and left it as a QuickTime movie export. | selected HDV/
HDTV 720p for a size, and a 30 frames-per-second frame rate, although

24fps also works well.

11. You're all done—just hit “Render.” See how it turned out and think

about what you can try differently next time.
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If you’re curious to see how
mine turned out, you can
watch it here on Vimeo:



https://vimeo.com/108395671

Flick off flickering

As you can see in my time-lapse video, there’s

a bit of what’s called “flickering” —the light
flickers on and off, as if someone is hitting a light
switch in the sky. This phenomenon is the result
of individual frames appearing to be over- or
underexposed relative to its surrounding frames.
Cameras, after all, aren’t perfect; sometimes

a cloud will swing by and alter a scene’s
luminescence.

There are in-camera techniques to naturally
reduce this, such as going full manual on all
settings (even white balance); using a manual
lens to reduce aperture flicker; or bulb ramping.
That last one might sound new—bulb ramping,
also called “bramping,” is a technique whereby
a photographer would use their camera’s bulb
setting to closely manage exposure and adjust it
over time throughout the time-lapse sequence.
DSLR exposure settings are limited to a third of
a stop, which means flickering occurs when the
camera jumps to the next exposure setting. A
bulb ramping device connects to your camera
and uses the camera’s bulb setting to override
the automatic third-step exposure changes.

But if you’re looking for simplicity, there are
several software products and plugins available
that do a fine job of removing flickering in post-
processing. One of the software applications

| mentioned earlier, LRTimelapse, works very
well for this; another popular plugin is called
GBDeflicker, which works with Adobe After
Effects and Premiere.

Controlling motion during time-lapse
videos

Want to add a whole new dimension to your
time-lapse photography? Try using a motion-
control pan head or mount instead of a
traditional tripod. This will move your camera
slightly between each shot, adding a whole new
element to the results. For instance, your camera
can pan down the length of a track, pausing
incrementally to take photos on its own—then,
when you put it together in post-processing, it
will look like a smooth movement into the scene.

If you’re looking for motion-control equipment,
I’d recommend Dynamic Perception as one of
the leading companies in this arena.

Hyperlapse

If you really want to take time-lapse photography
to the next level, hyperlapse is the answer.
Hyperlapse technology frees photographers

up from the shackles of silly old tripods, and
allows them to wander freely, snapping photos
constantly and merging them into a video.

Imagine walking down a hiking trail, taking a
photo every few steps, and then processing
them all together into a time-lapse video. It’s a
first-person account of a landscape experience.
Normally, such a product would appear jerky
and awkward, but hyperlapse software allows
users to crop and stabilize these photos to
create, for example, a smooth tracking sequence
through a large distance in the woods. Walking

down a busy street or hiking up to the peak of
a mountain and panning around —suddenly, a
whole world of movement opens up that tripod-
bound photographers can’t enjoy.

If you’re interested, | recommend Adobe After
Effects’ recently released Warp Stabilizer, which
can help process and stabilize hyperlapses
together.

After all this talk about video, you may as well
see a few. Take a look at these helpful video
tutorials on time-lapse photography:

® Time-lapse Photography Tips from
Start to End

How to Create a Time-lapse at Sunset

How to Make Star Time-lapses at Night

Motion Control Time-lapse Demonstrations

How to do Hyperlapse



http://lrtimelapse.com/
http://www.granitebaysoftware.com/products/productgbd.aspx
https://www.youtube.com/watch?v=TM7EJZ-8HWw&feature=youtu.be
https://www.youtube.com/watch?v=TM7EJZ-8HWw&feature=youtu.be
https://www.youtube.com/watch?v=wBi-ZPXCJjI&feature=youtu.be
https://www.youtube.com/watch?v=IQgpimEdfe0&feature=youtu.be
https://www.youtube.com/watch?v=WKM-CtsSjSI&feature=youtu.be
https://www.youtube.com/watch?v=PFUyxbh_ed0&feature=youtu.be

IPhone Photography

There are no definitive data sets on this subject, but let’s
be real for a moment: smartphones have become the most
widely used cameras in the world. (Imagine how many
selfies are taken each second—how many Instagram
shots, Snapchats, Vines and tweets—and you’ll likely
agree.) Apple’s iPhone is leading the pack, although
Android has been catching up for years and isn’t slowing
down. As the world develops, the numbers are only
increasing.

While smartphones obviously lack the sensor and power
of a DSLR, they gain points in the size department: phones
are always handy, always in our pockets. As a result, even
while I’'m traveling, if my SLR is stuffed into my backpack
and | want to grab a snapshot, I’ll whip out my phone—it’s
just more convenient.

That said, it’s important to know how to get the most out of
them. And, if you flip back through this entire book, you’ll
realize almost every tip applies just as much to iPhone as
to SLRs. Companies have caught onto this link between
smartphone and professional photography, too: they sell
tripods for iPhones, and you can set your iPhone camera
on a self-timer. You can even snap manual exposures
using camera replacement apps and also long exposures,
which are involved in a huge number of these photographic
tricks. It’s all right there, in that tiny pocket-sized rectangle.

Captured with iPhone 5, post-processed in the Camera+ app.
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Ditch the default

The later generations of iPhones have

decent cameras, which roughly replicate the
performance of a digital point-and-shoot. But
image quality isn’t their problem—focus is. If
you’re finding trouble getting clear shots even
during daylight, try holding the phone with two
hands and taking a deep breath while you’re
pressing the shutter. Also, I’ll mention this
because a surprising number of people don’t
know it, but you should always tap the focal
point of your image to tell the meter sensor
where to focus.

If you feel like moving up a notch, though, you
shouldn’t have to rely on the default camera.
Two good replacement apps are Camera+ and
ProCamera. Both allow you to set focus and
exposure independently, as well as manually
adjust the exposure, which are nice features for
those who take photos seriously. And, of course,
both also have a wealth of post-processing
options.

If I had to choose, though, I’d choose Camera+
in a heartbeat: it has a cleaner, more intuitive
interface and strikes me as much easier to use.

Processing tricks

Naturally, the best way to post-process iPhone
photos is to use Photoshop or Lightroom. But
in-camera (or should | say in-phone?) processing
apps are growing more and more sophisticated,
and offer a good alternative to editors in a hurry.
In some cases, the quality is outstanding—take
Camera+ for example, with a simple adjustment
called “Clarity” that blew me away when | first
tried it.

B.C.: Before Clarity in Camera+

| shot this image from the hip with an iPhone
while walking the streets of Shanghai, and the
Clarity scene adjustment simply brought it to life
through revived brightness and contrast.

These apps also offer loads of filter options that
can tweak any landscape or cityscape shot.
They’re similar to Instagram’s popular offerings,
including vintage and stylized face-lifts, but they
can also create much more subtle and effective
changes in color and tone.

o Verizen = 5114 PM

Edit

After Clarity in Camera+



Social smarts

| don’t need to tell you that most smartphone
photos find their homes on Facebook. And if
the images posted to social media were the
only judges of quality, then you might assume
smartphone photography to be of very poor
quality indeed. But this is far from the truth.

Whenever you upload a photo to Facebook
directly from a mobile device, Facebook actually
recognizes the type of device and compresses
the heck out of the image itself, cropping and
pixelating to fit it on the server without taking up
too much space.

In other words: Facebook sees you’ve taken a
photo on your phone and says, “This is probably
crap, so you probably won’t mind if it looks

like crap.” Facebook is now the world’s largest
photo sharing network by far, can you imagine
how much server capacity they would require

if they didn’t compress everyone’s smartphone
uploads?

Facebook does, however, recognize that
professional photographers sometimes want to
share high-quality images on their social media
pages. With that in mind, they’ve permitted
desktop and laptop computers to upload images
at higher resolutions. You should be able to

see this option when you’re uploading from a
computer—the upload and desktop load times
will be significantly longer, but you’ll be able to
see the difference.

And if you want to get the best possible
quality without overloading your social media?
Here’s the trick.

Resize your photo width to 2048 pixels from
your computer before uploading it. Given the
size and format, Facebook should accept and
display the image easily and clearly. (To be
honest, this applies to all images, not just ones
taken via smartphones—Facebook is a fickle
beast.)

So unless you’re breaking news by uploading

a photo to social media ASAP, hold off on
uploading the image—if you rush to upload

it from your phone, you’ll sacrifice quality for
time. Wait it out. Whenever | want to upload a
smartphone-taken snapshot, Il first upload it to
my computer, resize the width to 2048 pixels and
then—only then—toss it to the Facebook dogs.
If you don’t take my word for it, test it yourself.
You'll be surprised at how many friends are
suddenly impressed with your newfound skills.

Want to see smartphones tackle bigger
shots? Here are some helpful video
tutorials on smartphone photography:

m 7 Smartphone Photography Tips & Tricks

m jPhone Landscape Photography
Techniques

B The Best Camera is the One That’s With
You - Chase Jarvis



https://www.youtube.com/watch?v=fTz4Nhgm_SQ&feature=youtu.be
https://www.youtube.com/watch?v=2oVKfjRIcfo&feature=youtu.be
https://www.youtube.com/watch?v=2oVKfjRIcfo&feature=youtu.be
https://www.youtube.com/watch?v=buDa-m65RyA&feature=youtu.be
https://www.youtube.com/watch?v=buDa-m65RyA&feature=youtu.be

Extracting Frames from’i’ Videos

The world of professional videography and
photography is getting smaller and smaller,
and up-and-coming professionals in both
markets are growing up with both skills
handy. It makes sense: DSLRs shoot as
high quality video footage as almost any
camera, while new video cameras, like the
latest GoPro, record 4K video at a stunning
30 frames per second. That means each
frame shot on those settings is about eight
megapixels big. That’s huge.

With this crossover deepening, and video
quality getting better, imagers in several
industries have begun extracting key
frames from HD videos to process them
as photographs. This trend infuriates
some photographers—rightly so, if the
photographer takes up to 10 minutes to set
up a shot that a video can grab seemingly
randomly —but, frankly, the results are
starting to speak for themselves. These
days | view videos as one more place to
look for great photography.

Frame extracted from ContourHD video,
similar to GoPro, processed in Photoshap.

When someone looking to buy a photo
finds one, the way in which the photo was
captured tends to stop mattering. | learned
this personally. After successfully selling
an image extracted from video to a book
publisher, it reinforced my beliefs that
great photographs can come from almost
any camera—DSLR or otherwise—and
while my path to this particular extraction
technique was a bit unusual, I've found it
works wonders in situations where | can’t
carry a DSLR.

Photography Tricks 66



When you can’t carry a DSLR

A hobby of mine is wingsuit flying—that extreme
sport wherein people launch themselves from
airplanes wearing what are essentially flying
squirrel getups. Unlike skydiving or hang
gliding, in wingsuit flying your arms need to be
outstretched. Taking photos is hard. Carrying a
DSLR is harder.

While it’s possible to mount a DSLR on your
head and fire off photos using a mechanism
between your teeth, | decided against that route
due to the weight of it. (Occasionally a parachute
opens faster than expected, causing a “hard
opening” —this phenomenon, combined with
added weight atop your head, can seriously
damage your neck.) Since my neck is long

and frail enough without adding pounds to

it, | decided it was safer to mount a small
ContourHD camera on my head. The Contour

is essentially a GoPro with a more streamlined
shape, which is nice for aerodynamics and
reducing snag points that could interrupt a
parachute deployment.

That’s the way | capture all my wingsuit shots
these days: | record my flights using the highest
video resolution possible, and afterward mine
the footage for stills on my computer. It’s a tricky
process. Some shots have spectacular framing
but are too blurred from motion; others are crisp
but the subject is sticking out of the frame. Every
once in a while, though, with the right lighting
conditions, a frame pops up that actually works.

This is what led to one of my biggest photo
deals ever—a photo of mine being sold to a
major New York publishing company for a front
book jacket. Since it appeared on the cover, a
few photographers have asked me how | got this
image, so | figured I’'d share it in this book.

How frame extraction from video led to
a major photo sale

I’ve always wanted to fly in Dubai. The city’s
futuristic skyline and incredible depth struck me
as perfect—a glimpse into a possible future,

a way to connect with a reality we can only
imagine.

In that way, wingsuit flying is the perfect sport.
You can fly through the air like a bird—an
uncontrollable bird that can only fly downward
at extreme speeds. It’s not an easy way to

get into the sky, though. The United States
Parachute Association requires flyers to first
be knowledgeable skydivers, which involves
Assisted Free Fall training and a resume of 200
freefall skydives. An amazing adventure? Of
course. A dangerous pursuit? It can be.

But | still pursued it with extreme care, more for
the adventures than any professional drive. And
for me, Dubai—the cosmopolitan titan of the
Middle East, in the United Arab Emirates—was
high on the list of places | wanted to fly. | bought
a plane ticket as soon as | saved up enough
cash, and boarded the plane from Los Angeles.

Dubai’s dropzone is dangerously urban, so
before | could actually fly there, | had to prove
to them, essentially, that | wasn’t going to

fly into anyone’s 20th-floor office window.

After miraculously (and barely) passing their
parachute landing accuracy tests, they granted
me clearance to wingsuit at their lovely Palm
Islands dropzone. | was thrilled. The conditions
were a photographer’s dream during my first
flight—almost the golden hour, with a detailed
landscape hovering beneath me, few clouds to
obstruct my view and the infamous Palm Jebel
Ali islands ahead in the distance. It was on that
first flight, while chasing my friend in another
wingsuit, that | captured the image.

But it wasn’t until | reviewed the footage
afterward that | knew I’d caught something
special. | extracted a few stills from the best
moments. | edited together a video of the
experience, and you can actually see the still
I’m referring to at the 1:11 mark: https://vimeo.
com/54479746



https://vimeo.com/54479746
https://vimeo.com/54479746

The extraction process

In order to actually extract the stills from the
video, | like to use VLC Player. VLC is a free,
open-source multimedia player that consistently
works well and plays essentially anything. It
also has a feature that allows you to take a
“snapshot” at any frame.

So when nice images pop up in the raw

video footage—combinations of sheer luck in
composition and lighting—I paused it on the
best moments and take a snapshot. VLC will
save the still to your “My Pictures” folder (unless
you direct it otherwise) as a PNG, JPEG or TIFF
file.

| recommend opening your newfound snapshots
in Lightroom to start processing them like any
other photo. The quality, of course, won’t be

as strong as a RAW file from a DSLR, but if

you process carefully and subtly you can make
noticeable improvements. On this particular
image | didn’t have to do too much—

a little sharpening here, a color filter there;

| downplayed the blue sky and gave it more of a
“desert” feel, like how we discussed in an earlier
tutorial.
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Sharing is caring

Finding the photo is only the first half of it.

The second half is getting it out there. After |
edited this particular shot, | shared it on Flickr
with under a Creative Commons Attribution-
NonCommercial licence. | like that option
because it allows your photos to spread quickly
without necessarily giving it away for free. It can
still earn revenue from commercial projects with
permission—which is exactly what happened to
me.

It was on Flickr that a publishing company’s art
director saw my photo while seeking a cover
photo for a new book. They contacted me,

we discussed the fact that it was an image
extracted from video, but they still thought

it was the best image to represent the book.
The contract was signed, and the book was
printed and released to stores all over the world.
Sometimes it’s as lucky as that.
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Fly away

| wanted to end on this story to encourage you
to keep an open mind and think outside the
norm. For all the money I’'ve spent on camera
gear; for all the weighted tripods and filters,

the wide-angle lenses and primes; for all the
camera bodies I've upsold and upgraded—one
of my most successful and popular images
ironically came from a video still. It wasn’t a long
exposure, time-lapse or tilt-shift. | didn’t use
any of that fancy gear although | would have
liked to. I just kept an open mind and looked for
photography wherever possible.

And yes, there are elements of compositional
creativity there—a cool color palette, the rule of
thirds, a well-placed horizon line, and textures
within the clouds, sea and land. It’s a good
image. It adheres to the basic elements of art.
But it was also born from luck.

There is, quite literally, no way to know what

will work and what will fail. The only way you
can succeed is by looking at the world through
perspectives nobody’s seen yet. Take your
camera on an adventure; as the travellers say:
Get lost. Preserve that childlike sense of wonder
and explore the world around you.

After all, photography’s a great excuse.
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